ABSTRACT

Congenital heart defects (CHD) present with a wide variety of structural anomalies that range in severity, creating a need for personalized, precision treatment. Recent advances in diagnostic imaging and 3D printing technology have enabled the creation of patient-specific models, which have revolutionized the understanding and management of these conditions.

The objective of this research was to explore each step of generating such prints, and to establish a novel workflow for creating CHD models. The research focused specifically on creating aortic arch models optimized for surgical planning for patients with hypoplastic left heart syndrome (HLHS), a CHD in which the left heart and aorta are severely underdeveloped. Like most CHDs, there is substantial variability in HLHS anatomy, and the 3D shape of the aortic arch after reconstruction is critical in determining proper cardiac output, justifying a need to create customized 3D prints for improved surgical outcome.

While several software options exist for segmentation, this project concentrated on evaluating the following six to segment anatomy: Mimics, inPrint, OsiriX MD, Vitrea, D2P, and 3D Slicer. Meshmixer and 3-matic were used to manipulate the data exported from the segmentation software, to create life-sized models of pre-operative anatomy, an approximation of desired post-operative anatomy, and a customized homograft patch for aortic arch reconstruction. The models were printed on a Stratasys Connex3 Object260 printer using Tango Plus flexible material to allow surgical suturing.

Although some models were segmented from CT acquired data, emphasis was placed on establishing methods for utilizing 3D ultrasound derived data. This alternative provides a safe, cost-effective, and accessible imaging modality without harmful radiation, contrast, or anesthesia in vulnerable pediatric patients. Additional proof of concept models were derived from 3D fetal cardiac ultrasound data, since the first stage operation for HLHS—as well as other complex CHDs—must often be performed days after birth. Customized 3D printed models have the potential to improve treatment planning, reduce procedure time, and improve patient outcomes. The Workflow proposed in this project facilitates a safer and more effective method for producing 3D printed models of a pediatric heart.

Author: Sarah A. Chen
CHAIRPERSONS OF THE SUPERVISORY COMMITTEE

Preceptor: Narutoshi Hibino, M.D., Ph.D.
Assistant Professor of Cardiac Surgery, Johns Hopkins Hospital

Faculty Advisor: Juan R. García, M.A., C.C.A.
Associate Professor of the Department of Art as Applied to Medicine,
Johns Hopkins University School of Medicine
I would like to thank Dr. Narutoshi Hibino, for serving as my preceptor and instigating the very inquiry that fueled this wonderful exploration. His extensive surgical expertise, valuable feedback, and enthusiasm were integral to the advancement of this project, and I am grateful for the time he took to meticulously evaluate my 3D printed models. Thanks to Juan García, my faculty advisor, for his unwavering support and guidance, and for being an advocate of my success and encouraging me to push the boundaries to come up with creative solutions. I greatly appreciate his 3D printing expertise and proactive networking efforts, which allowed me to sample a range of cutting edge technology.

In the true collaborative spirit of medical illustration, I would also like to extend my heartfelt appreciation to a multitude of people from a number of departments, without whom this project would not have been possible. From pediatric cardiology, thank you to Dr. Priya Sekar for helping me access echocardiography data. Special thanks goes to Cathy Evans, who kindly spent many hours with me in the echo lab and helped me make sense of ultrasound imaging. Thanks to Dr. Philip Spevak and Dr. Luca Vricella for their uplifting words, and Diane Alejo for helping me with IRB logistics. From radiology, thank you to Dr. Nagina Malguria for helping me access cardiac CT datasets, and more importantly, helping me to decipher them. Thanks also to Dr. Stefan Zimmerman for responding to my inquiries. From maternal fetal medicine, thank you to Dr. Jena Miller and Cici McShane, for helping me acquire 3D fetal ultrasound data, and sharing an interest in medical 3D printing.

Thank you also to all of the representatives who generously allowed me to use proprietary 3D segmentation software, some of which were still in the beta phases. Many thanks to Maureen Schickel and Todd Pietila from Materialise, for their long continued support and invaluable expertise. Thanks also to Ilan Shacham from 3D Systems, Yeshai Goodman from Vital Images, Yves Martel from TomoVision, and Nick Kloski from HoneyPoint3D for their support.

Thanks to everyone at the Carnegie Center for Surgical Innovation for making me feel welcome whenever I visited the 3D printing lab. Thank you to the Vesalius Trust for their generous grant to help fund this project, and to Sarah Poynton for her astute feedback on my proposal. Thanks also to Norm Barker for sharing his photography equipment and expertise.
To my dear classmates Dan, Ellie, Julia, Katie, Li, and Nick—as well as the classes of 2016 and 2018—thank you for being a constant uplifting and inspiring presence, and for the lifelong friendships. Thanks also to Ingy Soliman for suggesting the clever water flosser idea. Thanks to the incredible faculty at the Department of Art as Applied to Medicine for creating a nurturing environment for us to thrive creatively and professionally. Special thanks to Cory Sandone and Kimberly Duncan for introducing me to Dr. Hibino and facilitating this research project in the first place.

Thanks to Chris, for his endless support, and steady stream of encouragement and boxes of chocolate to keep me going through many late nights. Thanks to my parents and sisters for their unconditional love and support always.

This was truly a multidisciplinary effort, and I look forward to future collaborations to expand and improve upon this project.
# TABLE OF CONTENTS

ABSTRACT ......................................................................................... ii  

Chairpersons of the Supervisory Committee ........................................... iii  

ACKNOWLEDGEMENTS ............................................................. iv  

INTRODUCTION ........................................................................ 1  

Congenital Heart Defects ................................................................. 1  

Hypoplastic Left Heart Syndrome ................................................ 2  

A Need for Pre-surgical Planning in CHD Repair .............................. 6  

3D Printing Applications in Cardiology: ......................................... 8  

Cardiovascular Imaging Data Acquisition ......................................... 10  

Post-processing of Imaging Data .................................................... 17  

Generation of 3D Printed Models ................................................ 21  

The Role of Medical Artists in Creating 3D Prints. ........................... 23  

Designing a Custom Model for HLHS Surgical Planning ................. 23  

Objectives ................................................................................... 24  

A Multidisciplinary Collaborative Approach ................................ 24  

MATERIALS AND METHODS ..................................................... 26  

Cardiovascular Imaging Data Acquisition ........................................ 26  

CT ......................................................................................... 26  

3D Ultrasound ............................................................... 26  

3D Fetal Ultrasound ......................................................... 27  

Post-processing of Imaging Data .................................................. 28  

Segmentation of Cartesian DICOM – CT .................................. 28  

Segmentation of Non-Cartesian DICOM – Ultrasound ................. 38  

Mesh Clean Up ........................................................................... 42  

Model Optimization ..................................................................... 42  

Determining Limits of Print Thickness ......................................... 43  

Pre-op HLHS Model .................................................................. 44  

Approximated Post-op HLHS Model ........................................... 45  

Homograft Model ...................................................................... 47
FIGURES

Fig. 1: Normal vs. HLHS cardiac anatomy. ............................................ 2
Fig. 2: Three stages involved in surgical palliation of HLHS. ...................... 4
Fig. 3: Aortic arch reconstruction during the stage I Norwood repair for HLHS. 5
Fig. 4: “Prototype” template for post-Norwood aortic arch reconstruction. .... 7
Fig. 5: Examples of problematic aortic arch morphology after Norwood repair. 8
Fig. 6: Suprasternal notch view for examining aortic arch with ultrasound .... 13
Fig. 7: 3D ultrasound derived cardiac models. ........................................ 14
Fig. 8: Images obtained by STIC/TUI imaging. ........................................ 15
Fig. 9: 3D STIC-HDlive rendering showing reconstruction of fetal heart. ....... 15
Fig. 10: 3D HDlive rendering of right ventricular outflow tract view of HLHS. 15
Fig. 11: B-flow imaging of aortic arch.................................................... 15
Fig. 12: 3D ultrasound to 3D print of fetus. .......................................... 16
Fig. 13: Cartesian vs. non-Cartesian coordinate systems. .......................... 18
Fig. 14: Baby SliceO by TomoVision .................................................... 19
Fig. 15: QLAB interface. ................................................................. 27
Fig. 16: Setting threshold values for CT heart segmentation in Mimics. ...... 28
Fig. 17: Cropping mask in Mimics ...................................................... 29
Fig. 18: 3D object calculated from mask in Mimics. ................................. 29
Fig. 19: Final 3D model from Mimics .................................................. 30
Fig. 20: Overview of 5 steps in inPrint ................................................ 30
Fig. 21: Resulting ROI after thresholding in inPrint ................................. 31
Fig. 22: Using “Erase” tool in the 3D view in inPrint. ............................... 31
Fig. 23: 3D model after hollowing in inPrint ......................................... 32
Fig. 24: Final segmentation result in inPrint .......................................... 32
Fig. 25: Defining threshold values to define ROI in OsiriX MD ................. 33
Fig. 26: Using "Scissors" tool in OsiriX MD ........................................... 33
Fig. 27: Vitrea software interface ....................................................... 34
Fig. 28: “Segment Anatomy” menu in Vitrea ......................................... 34
Fig. 29: “Grow” tool being used in Vitrea ............................................ 35
Fig. 30: “Multi-Slice” tool to remove unwanted anatomy in Vitrea .......... 35
Fig. 31: Cropping boundaries of anatomy in D2P .............................................. 36
Fig. 32: Adding markers to the cardiac blood pool in D2P .................................. 36
Fig. 33: Result of “Cardiac Segmentation” tool in D2P ....................................... 37
Fig. 34: Using “Scissors” tool in D2P ................................................................. 37
Fig. 35: Resulting 3D mask in D2P ................................................................. 37
Fig. 36: 3D Slicer interface and completed segmentation .................................... 38
Fig. 37: Setting orientation for 3D ultrasound data in Mimics .............................. 39
Fig. 38: Result of segmenting 3D ultrasound aortic arch data ............................ 40
Fig. 39: Final result of aortic arch segmentation from 3D ultrasound data ............ 40
Fig. 40: Setting orientation for 3D fetal cardiac ultrasound data in Mimics ............. 41
Fig. 41: Finished segmentation of fetal cardiac blood pool ................................. 41
Fig. 42: Final result of fetal heart segmentation from 3D fetal ultrasound data ...... 42
Fig. 43: Example of 3D mesh file brought into 3-matic ........................................ 42
Fig. 44: Creation of pre-op and post-op HLHS aortic arch models ....................... 43
Fig. 45: "Extrude" function in Meshmixer .......................................................... 43
Fig. 46: Models to test limits of print thickness .................................................... 43
Fig. 47: Creating a pre-op HLHS model by “undoing” Norwood operation ........... 44
Fig. 48: Pre-operative HLHS aortic arch anatomy ............................................. 44
Fig. 49: Surgical view during Norwood operation ............................................. 45
Fig. 50: Creation of support walls in Meshmixer ............................................... 45
Fig. 51: Cuts made to pre-operative model to mimic Norwood operation ............... 46
Fig. 52: Manipulating geometry with “Warp” tool ............................................. 46
Fig. 53: Designation of homograft on post-op model .......................................... 46
Fig. 54: Second version of homograft patch created .......................................... 47
Fig. 55: Homograft patch, isolated from post-op model ...................................... 47
Fig. 56: Creation of a pulmonary artery homograft .............................................. 48
Fig. 57: Second hypoplastic aortic arch model ................................................. 48
Fig. 58: Ultrasound derived aortic arch model ................................................... 49
Fig. 59: SUP706 support material surrounding 3D printed models ...................... 50
Fig. 60: Using a Waterpik water flosser to remove SUP706 support ..................... 50
Fig. 61: 2% NaOH solution used to help remove SUP706 support ....................... 50
Fig. 62: Preliminary “surgery” performed on pre-op HLHS aortic arch model. ............... 51
Fig. 63: Simulating surgery on pre-op HLHS model. .................................... 51
Fig. 64: Proposed workflow for creating customized 3D printed models ....................... 53
Fig. 65: “Inspector” results of exported STLs (CT derived) .................................. 56
Fig. 66: “Inspector” results of exported STLs (ultrasound derived) .......................... 57
Fig. 67: Digital model: pre-op HLHS model .................................................. 58
Fig. 68: Digital model: approximated post-op HLHS model (version 1) ...................... 58
Fig. 69: Digital model: approximated post-op HLHS model (version 2) ...................... 58
Fig. 70: Digital model: customized homograft model (version 1) ............................. 59
Fig. 71: Digital model: customized homograft model (version 2) ............................. 59
Fig. 72: Digital model: additional hypoplastic aortic arch model ............................ 59
Fig. 73: Digital model: 3D ultrasound derived model of adult aortic arch anatomy .......... 60
Fig. 74: Digital model: 3D fetal ultrasound derived model of fetal heart .................... 60
Fig. 75: 3D print: aortic arch models created to determine print thickness limit ............... 62
Fig. 76: 3D print: cut edge view of aortic arch models (pre-op) ............................... 62
Fig. 77: 3D print: preliminary pre-op HLHS models ......................................... 63
Fig. 78: 3D print: pre-op HLHS model with supports ....................................... 63
Fig. 79: 3D print: approximated post-op HLHS model (version 1) .......................... 64
Fig. 80: 3D print: approximated post-op HLHS model (version 2) .......................... 64
Fig. 81: 3D print: homograft model (version 1) ................................................ 65
Fig. 82: 3D print: homograft model (version 2) ................................................ 65
Fig. 83: 3D print: pulmonary artery model ....................................................... 65
Fig. 84: 3D print: additional hypoplastic aortic arch model ................................... 66
Fig. 85: 3D print: 3D ultrasound derived aortic arch model ................................. 66
Fig. 86: 3D print: 3D fetal ultrasound derived fetal cardiac model ........................... 67
Fig. 87: Result of preliminary surgical simulation using aortic arch models .................. 68
Fig. 88: Result of surgical simulation using version 1 of the homograft patch ............... 69
Fig. 89: Result of surgical simulation using version 2 of the homograft patch ............... 69
Fig. 90: Suprasternal notch view of neonate with hypoplastic aortic arch ..................... 74

TABLE

Table 1: Segmentation software chart ............................................................. 54
INTRODUCTION

Congenital heart defects (CHDs) affect nearly 1% of births (CDCP, 2016). Due to the extensive variability of malformations, patient-specific 3D printed models can aid in the understanding and management of conditions arising from such complex anatomy. 3D printed heart models have become an increasingly used tool in the care of CHD patients, from patient education to personalized surgical planning and customized implants.

Despite the rising popularity of these models for medical use, there is still no standardized approach for producing 3D printed models. The creation of 3D printed models involves three sequential steps: (1) imaging data acquisition; (2) data post-processing; and (3) generation of the physical 3D printed model, and there are several approaches and options to consider in each of the steps, with multiple workflows available based on the given imaging modality and software/hardware options.

The objective of this research was therefore to explore and assess these options, and to establish a comprehensive workflow for creating 3D printed CHD models. Emphasis was placed on creating ultrasound derived models, since ultrasound is a safe imaging modality that does not pose harmful risks to vulnerable pediatric patients. The research focused specifically on printing aortic arch models optimized for surgical planning for patients with hypoplastic left heart syndrome (HLHS), a CHD in which the left heart and aorta are severely underdeveloped. The 3D shape and size of the aortic arch, such as its curvature and diameter, after reconstruction in HLHS patients is crucial in determining cardiac outcome, justifying a need to create customized 3D printed models for improved surgical planning. In addition, digital modeling tools were used to approximate the shape of a patient-specific post-operative aortic arch model, as well as the shape of the customized homograft patch that would be used in the repair. The creation of such models can facilitate more streamlined surgeries to ultimately improve patient outcomes.

CONGENITAL HEART DEFECTS

A congenital heart defect (CHD) is a structural defect of the heart present at birth. CHDs are the most common type of birth defect, and can present with a wide variety of structural anomalies that range in severity. Roughly a quarter of infants are born with a critical CHD, and will require some kind of
surgery or intervention within the first year of life (CDCP, 2016).

HYPOPLASTIC LEFT HEART SYNDROME (HLHS)

Hypoplastic left heart syndrome (HLHS) is a life-threatening CHD that encompasses a heterogeneous group of cardiac defects that results in the underdevelopment of the left heart and related structures (Fig. 1). The Congenital Heart Surgery Nomenclature and Database Committee states that:

“HLHS is a spectrum of cardiac malformations, characterized by a severe underdevelopment of the left heart-aorta complex, consisting of aortic and/or mitral valve atresia, stenosis, or hypoplasia with marked hypoplasia or absence of the left ventricle, and hypoplasia of the ascending aorta and of the aortic arch.”

It is estimated that about 960 infants in the United States are born with HLHS each year (Parker et al., 2010), and though HLHS comprises only a portion of all CHDs, it is the most common cause of death from a CHD within the first week of life (Stout & Lewin, 2012). If no intervention is taken, the mortality rate of HLHS patients is about 98% in the first 6 weeks of life (Greenleaf et al., 2016).

The underdevelopment of the left heart structures in HLHS leads to an inability of the left heart to support systemic circulation. The dominant right ventricle is then responsible for providing blood flow to the body; an atrial septal defect allows for shunting of blood from the left atrium to the right atrium, and a patent ductus arteriosus (PDA) enables blood flow to the aorta and coronary arteries.
Introduction

The PDA is often large, close to 10 mm in diameter, and seen as a direct extension of the main pulmonary artery, which is even larger (11–15 mm or more in diameter). Systemic circulation depends on the patency of the PDA; complete closure of the PDA is fatal.

Surgical Palliation for HLHS

The goal of HLHS palliation is to enable passive flow of systemic venous blood directly to the lungs and allow the single working right ventricle to pump oxygen-rich pulmonary venous blood back to the body (the term palliation, rather than treatment, is used because the surgery does not restore normal cardiac anatomy, but rather modifies it in a way that is compatible with life). The procedure required to accomplish this typically occurs in three separate stages (Fig. 2).

The first stage, called the Norwood procedure, allows the right ventricle to pump blood to both the body and lungs without the need for the PDA to be kept open. To do this, the atrial septal defect is surgically enlarged (atrial septectomy) to allow free blood flow from the left to right atrium, and a homograft patch is used to construct a neoaorta to restore proper systemic blood flow. Blood flow to the lungs is then directed either through a Sano shunt (right ventricle to pulmonary artery) or a Blalock-Taussig (BT) shunt (subclavian or carotid artery to pulmonary artery). The Norwood procedure is typically performed within the first few days of life.

In the second stage, referred to as the Glenn procedure or the superior cavopulmonary connection, the shunt is removed and pulmonary flow is restored by directly anastomosing the superior vena cava (SVC) to the pulmonary artery. This operation is usually performed between 4 and 6 months of age.

In the third stage, the Fontan procedure, the inferior vena cava (IVC) is connected to the right pulmonary artery via an extracardiac total cavopulmonary connection (TCPC). This conduit allows for venous return from the IVC to flow directly into the pulmonary artery. The Fontan is usually performed between 18 months and 3 years of age. After the Fontan is completed, all systemic venous blood will bypass the right heart and return directly into the pulmonary circulation. This allows the right ventricle to pump only oxygenated blood to the body and prevents mixing of oxygenated and deoxygenated blood.
3 Stages of Surgical Palliation for HLHS

Stage 1: Norwood
- ① Aortic reconstruction
- ② Atrial septectomy
- ③ Shunt: either Sano (A) or Blalock-Taussig (B)

Stage 2: Glenn
- Shunt taken down
- SVC–PA cavopulmonary connection

Stage 3: Fontan
- IVC–PA cavopulmonary connection

Extracardiac total cavopulmonary connection (TCPC)

Fig. 2: The three stages involved in surgical palliation of HLHS. The first stage of repair is called the Norwood operation; the second is the Glenn, and the third is the Fontan.
Of these steps, the shape of the homograft used in constructing the neoaorta during the Norwood operation is of particular importance (Fig. 3).

Fig. 3: Aortic arch reconstruction using a pulmonary artery homograft during the stage I Norwood procedure for HLHS. A: hypoplastic arch seen in HLHS anatomy. B: patent ductus arteriosus (PDA) and main pulmonary artery (MPA) are divided. C: incision of aorta (aortotomy) under arch. D: completion of neoaortic arch reconstruction with pulmonary artery homograft.
To construct the neoaorta, the PDA is first divided at its junction with the descending aorta, followed by division of the main pulmonary artery (MPA). The underside of the aortic arch is cut slightly past the isthmus (portion of the aorta between the left subclavian artery and ductus arteriosus) distally, and to the level of the divided MPA proximally. A V-shaped incision is made in the proximal MPA, where the ascending aorta will be anastomosed. The neoaortic arch is reconstructed using a homograft, which can be from a donor pulmonary artery, aorta, or femoral vein (at Johns Hopkins, the preference is for a pulmonary artery homograft). The homograft must be shaped appropriately for the arch reconstruction according to the length and diameter of the arch; too large a size can cause pulmonary artery compression posteriorly, while too small a size can result in a neoaortic pressure gradient.

A NEED FOR PRE-SURGICAL PLANNING IN CHD REPAIR

Although surgical management of CHDs has improved drastically over time, mortality remains high. Current expected survival for the stage I Norwood palliation is 85.1% (Greenleaf et al., 2016), which is a tremendous jump from when the condition used to be almost universally fatal; however, improvements can still be made. The heterogeneity of patients with these kinds of complex CHDs has created a need for personalized, precision management.

Variability of HLHS and the Need for Patient-specific Models

It is imperative to note that, like most CHDs, there is substantial variability in HLHS anatomy. The ascending aorta and aortic arch are variable in length and hypoplastic to different degrees, and can also depend on the morphology of the aortic valve. The ascending aorta may be less than 2.5 mm in a neonate presenting with aortic atresia (valve is absent), or up to 4–5 mm in a neonate with aortic stenosis (valve is narrowed). The length and diameter of the main pulmonary artery are also important factors that can influence the ultimate shape of the homograft patch. Finally, the length and direction of the ductus arteriosus can be particularly influential in the outcome of the surgery: the ductus may be short and course directly superiorly so that the aortic arch is very short and arch reconstruction is straightforward; or, it may be very long and curve posteriorly and inferiorly so that exposure of the arch reconstruction distally poses a challenge (Jonas, 2014).
Introduction

As a result, the three-dimensional shape of the aortic arch after surgical palliation varies widely in both shape and size depending on the anatomy of the patient, as well as the surgical technique. Arch morphology following the Norwood procedure has been found to be especially critical in determining cardiac function and outcome (Bruse et al., 2016). Deformations or deviations from a “prototype” template determined by Bruse et al. (Fig. 4) has been correlated with disadvantageous outcomes, including poorer cardiovascular function and longer ICU or hospital stays.

![Fig. 4: The “prototype” template for post-Norwood aortic arch reconstruction (figure from Bruse et al., 2016).](image)

Problematic arch morphology includes indentations (“hourglass” indentation between aortic root and transverse arch), Gothic arch shape, severe size mismatch between the dilated transverse and narrow descending aorta, and non-uniform arch continuation (Fig. 5). Oversized aortic root and dilation of the neoaorta after surgery are also common issues, and occur because the diameter of the pulmonary root, which is used to create the neoaortic root, is larger than the aortic root of healthy subjects. Unfortunately, grossly abnormal aortic shape may disrupt normal aortic blood flow (Voges et al, 2010).

In cases like this, the creation of a patient-specific surgical guide can aid surgeons in more precisely planning the procedure, and alleviate some of the size and shape mismatch issues. In addition, surgical simulation with customized 3D printed models can lead not only to more precise, but shorter, surgeries as well, and therefore reduce the costs and consequences of longer operating times. The Congenital Heart Surgeons’ Society performed a comprehensive outcome analysis of patients undergoing the
stage I Norwood procedure, and found that, among institutional variables and patient-specific variables such as low birth weight, procedural variables—including longer circulatory arrest time and management of the ascending aorta—posed risk factors for death (Ashburn et al., 2003). A study by Goldberg et al. also found that the use of circulatory arrest was predictive of suboptimal neurodevelopmental outcomes (2000). For pediatric cardiac cases, shorter operating room time means reduced circulatory arrest time, which ultimately translates to better quality of life; such benefits, and more, may be facilitated by the use of a medical 3D printed model (Giannopoulos et al., 2016).

**3D PRINTING APPLICATIONS IN CARDIOLOGY:**

Medical 3D printing refers to the creation of physical anatomical structures derived from volumetric data sets from various imaging modalities, to allow for the visual inspection and tangible manipulation of hand-held models of human anatomy and pathology that provide unparalleled tactile perception. Following the successes of 3D printing in dental, maxillofacial, and orthopedic interventions, 3D cardiovascular printing has been increasingly explored. Cardiovascular 3D printing applications include advanced visualization and diagnosis, planning and simulation for surgery and interventions, research, education, and patient-physician communication. Documented benefits of cardiovascular 3D printing include reduction in intraoperative time as well as postoperative complications, from decreased blood loss and anesthesia time and fewer revision procedures. Other benefits include reduced cardiopulmonary bypass time, decreased fluoroscopy/contrast exposure, enhanced surgical precision, avoidance of unnecessary surgery, and superior training opportunities for surgeons by replacing scarce cadaveric models with 3D printed models (Giannopoulos et al., 2016). The advantages that
Introduction

these models can provide are especially important for young CHD patients who are more sensitive to procedural risks. Numerous studies and uplifting anecdotes have presented cases in which 3D printed heart models were used to improve surgical education and procedural outcomes.

The International Medical Image Bank for Congenital Heart Diseases (IMIB-CHD), for instance, has highlighted the revolutionary role 3D printing plays in the surgical treatment of CHDs. IMIB-CHD is a nonprofit organization that gathers CHD imaging data to construct 3D printed heart models for education and research purposes. From a didactic standpoint, cardiovascular surgical training remains opportunity based, and uniform exposure of various pathologies and procedures is limited. 3D printed models optimized for hands-on surgical training, however, can help expose trainees to rare anatomical morphology. One of IMIB-CHD’s studies demonstrated that using 3D printed models actually improved assessment scores of residents, cardiologists, and radiologist in training sessions (Yoon Solutions, 2017). A related organization, 3D Hope Medical, also offers printing services for 3D heart models designed for use in pre-operative and pre-interventional assessment, as well as simulation of procedures (Yoon Solutions, 2013).

The use of 3D printed models for surgical simulation is also becoming more widespread. A team at Children’s Hospital of Michigan used a 3D printed model of a patient’s unique aortic anatomy to simulate stent placement in a catheterization lab. Performing this ‘practice-run’ before the actual procedure reduced the risk of complications, and helped shorten hospital stay and recovery time (Millsaps, 2015). For HLHS cases specifically, simulation of second-stage surgical repair for HLHS prior to the actual operation was shown to be feasible using 3D printed models (Kiraly et al., 2016 and Shiraishi et al., 2010). Without question, a physical, 3D printed CHD model can offer improved spatial comprehension of complex cardiac structures (Hadeed et al., 2016), and can even facilitate unequivocal surgical decision making (Riesenkampff et al., 2009).

Still, despite the many success stories and excitement surrounding the advent of medical 3D printing, several restrictions and technical challenges persist. Several, often time consuming, steps are involved in the production of a 3D printed model, and while several workflow protocols exist, there is still no
standard or uniform way to create the models. Overall, creation of a 3D printed cardiac model can be broken down into three sequential steps: (1) imaging data acquisition; (2) post-processing of image data; and (3) generation of a physical 3D printed model. There are multiple approaches, options, and limitations to consider in each of the three steps, and will be discussed in order.

**CARDIOVASCULAR IMAGING DATA ACQUISITION**

The first step towards building a 3D printed model is 3D imaging data acquisition. The ideal scanned imaging data provide visuals in which the anatomy of interest can be differentiated from surrounding structures, and have adequate signal intensity and contrast with minimal artifact. To date, most 3D printed heart models have been created from computed tomography (CT) or magnetic resonance imaging (MRI) data. Models of tissue architecture, such as ventricles and atria, are created using CT or MRI, while models of the vascular lumen—created for intravascular intervention planning purposes, for example—can be derived from any 3D angiographic modality such as CT angiography (CTA) or magnetic resonance angiography (MRA) (Giannopoulos et al., 2016).

Medical images are almost universally stored in Digital Imaging and Communications in Medicine (DICOM) format, which is a standard for handling, storing, and transmitting patient and imaging data from several modalities including MRI, CT, ultrasonography, and radiation therapy. The DICOM file format allows for integration of medical imaging devices, from scanners and servers to workstations and printers, from several manufacturers. A Picture Archiving and Communication System (PACS) enables DICOM image files from multiple modalities to be stored, transferred, and accessed electronically. 2D workstations can interpret the signal values stored in DICOM files to display 3D volume formats on a flat monitor, for clinicians to review.

The quality of the model and ease of 3D segmentation is heavily dependent on the properties of the imaging source data. Accurate models can be created when the slice thickness of the images are 0.50–1.25 mm (Meier et al., 2017); however, with neonatal and pediatric patients, obtaining optimal imaging resolution is more challenging. Imaging of young patients often presents with movement and breathing artifacts, and higher heart rates require faster scanning which can compromise resolution.
Fast image capturing time is therefore the most important factor for acquiring motion-free cardiac images in children (Aramson, 2012).

**CT**

Computed tomography (CT) employs penetrating x-rays to produce cross-sectional images of the scanned anatomy. For visualizing cardiac vessel anatomy, CT angiography (CTA) is used, and involves the injection of IV contrast media. CT scans are completed on the order of seconds to minutes, and costs range from a few hundred to a few thousand dollars. For very ill patients, the speed of CT imaging and its accessibility make it the imaging modality of choice over MRI (Chan & Hanneman, 2015). The major strength of CTA is its capability to show extracardiac vascular pathologies. CT scans have been used extensively to create 3D printed models, and model quality tends to be high with good anatomical accuracy.

**MRI**

Magnetic resonance imaging (MRI) uses magnetic fields to generate images of internal anatomical structures. No ionizing radiation is involved, and therefore MRI poses no cancer risks. MRI scans are completed on the order of minutes to hours, and typically cost more than a CT scan. MRI scans have also been used routinely to create 3D printed models with high anatomical fidelity.

**Imaging Considerations for Neonatal and Pediatric Cases**

It is important to consider that for infants and children less than 5 years of age, sedation or general anesthesia is often indicated for these advanced imaging modalities. In addition, CT poses an inherent cancer risk, as ionizing radiation may disrupt genes that regulate cell division. This is particularly concerning for pediatric patients, since immature developing cells are more susceptible to disruption of their genetic infrastructure. Compared to adults, children and infants also have longer expected lifetimes to express cancer after a given radiation exposure. The contrast agent used for CTA imaging also carries a risk for renal damage. Though radiation risks are not an issue with MRI for evaluating neonatal cardiac anatomy, MRI requires general anesthesia with a long examination time (about 64 min) (Kim et al., 2013). Usage of CT versus MRI for CHD imaging varies based on institutional
preferences, but MRI also tends to be more limited in daily practice, and is usually less available.

**Using Ultrasound Data to Create 3D Printed Models**

While approximately 90% of 3D printed models are derived from CT or MRI, the remainder are created from 3D ultrasound data (Byrne et al., 2016). This contrasts sharply with imaging trends in clinical centers in which the majority of cardiac visualization is done with ultrasound. One heart clinic reported that for imaging of CHDs, ultrasound comprised 96.1% of all studies, while cardiac CT and MRI scans were used sparingly (Han et al., 2013). Advanced diagnostic imaging is only ordered in a small percentage of cases in which ultrasound is insufficient; therefore, it is sensible to explore ways to create 3D prints from ultrasound data. Ultrasound also has the advantage of being safer, more accessible, and less costly than CT or MRI.

In fact, patients with HLHS are usually diagnosed and sent for stage I surgical palliation with ultrasound as the only mode of evaluation (Kulkarni et al., 2015). CT scans for HLHS patients are typically only done after the Norwood procedure to evaluate operational details in preparation for the second and third stage surgeries (Han & Lesser, 2013 and Goitein et al., 2014); MRI may also be used to evaluate post-Norwood anatomy (Voges et al., 2010 and Valsangiacomo Buechel et al., 2015). Because of this standard of care, CT/MRI scans of pre-operative HLHS anatomy, before any surgical palliation, are rarely performed.

**2D Ultrasound**

2D echocardiography, or ultrasound of the heart, remains the first-line imaging tool for diagnosing CHDs (Zeng et al, 2016). Most CHDs are diagnosed with 2D ultrasound; the diagnosis of HLHS is also being made with increasing frequency by prenatal ultrasound. Ultrasound exam for HLHS patients is excellent for showing the morphology of the mitral and aortic valves, the volume of the left ventricle, and any of the left-sided anomalies characteristic of HLHS. Ultrasound is the primary imaging modality used to image the aortic arch, which is best viewed from the suprasternal notch view (Goudar et al., 2016) (Fig. 6).
2D ultrasound is portable, relatively user friendly, provides high temporal resolution, and is safe, which are important considerations especially when treating neonatal or pediatric patients. However, CHDs often present with complex 3D pathology, which cannot be adequately described by 2D imaging methods that lack crucial spatial information. Routine ultrasound images, though non-invasive, are generated as individual “slices” without orientation and with a limited field of view lacking depth, and therefore not ideal for 3D printing (Giannopoulos et al., 2016). However, advances in imaging technology in the last decade have allowed for improved 3D ultrasound scans that have paved the way for 3D ultrasound derived 3D printed models.

3D Ultrasound

Like 2D ultrasound, 3D and 4D (i.e. real-time 3D) ultrasound eliminates the need for sedation, anesthesia, or radiation required of CT or MRI scans. Although the resolution of ultrasound is not as robust as CT or MRI, 3D ultrasound is being increasingly used to create 3D prints, and the feasibility of 3D printed CHD models derived from 3D ultrasound has been demonstrated for septal (Samuel et al., 2015) and valvular (Mahmood et al., 2015) defects from transesophageal (TEE) and transthoracic (TTE) echocardiography data (Fig. 7). Olivieri et al., verified the accuracy of models created from
Introduction

3D ultrasound data of CHD patients (2015). Although 3D ultrasound data do not allow visualization of the whole heart in its entirety, focusing on one area reduces the time and labor involved in the segmentation process. In addition, the real time nature of ultrasound may also confer an advantage over CT and MRI in depicting anatomy in different phases of the cardiac cycle, to facilitate a more dynamic understanding of cardiac function (Farooqi & Sengupta, 2015).

3D Fetal Ultrasound

While conventional 2D ultrasonography remains the gold standard for diagnosing CHDs, advances in 3D/4D ultrasound for assessing the fetal heart have made this technology more applicable for detecting CHDs in utero. A relatively new technique called Spatiotemporal Image Correlation (STIC) allows for 3D volume data acquisition and reconstruction of the fetal heart and its vascular connections, which enables more accurate detection of CHDs (Araujo Júnior et al., 2014). In addition, a technique within STIC called Tomographic Ultrasound Imaging (TUI) also makes it possible to attain all parallel axis planes of the heart, with images similar to CT, which can help detect CHDs as well (Adriaanse et al., 2016) (Fig. 8).

Another technique called B-flow imaging improves signals reflected from blood, and makes it possible to identify large and small vessels, even those with low flow velocity, such as pulmonary veins. B-flow
imaging has been used to visualize aortic arch anomalies, providing insight into the precise location and 3D spatial nature of abnormal vascular arrangements (Espinoza et al., 2009) (Fig. 9).

New software called HDlive, first available on the GE Voluson E8 ultrasound machine, has also offered a novel rendering algorithm for assessing fetal heart structures and enables volumetric reconstruction of the entire fetal heart and its connections (Araujo Júnior et al., 2013) (Fig. 10). This technology has been used to assess HLHS cases in utero, and has revealed cardiac anomalies in robust detail (Hata et al., 2013) (Fig. 11).
Introduction

Such novel applications of 3D ultrasound in assessing fetal CHDs have allowed for the detection and three dimensional visualization of all extracardiac vessels, including the aorta, pulmonary artery, ductus arteriosus, inferior vena cava, and ductus venous (Hongmei et al., 2012). Fetal 3D/4D ultrasound has been shown to be superior to traditional 2D ultrasound in some cases for detecting aortic arch and related vessel anatomy (Zhang et al., 2015). Another advantage of 3D/4D ultrasound over 2D ultrasound examination of the fetal heart is the shorter scanning time (about 3–4 minutes) (Ionescu, 2010). In utero detection and advanced visualization of CHDs with fetal 3D ultrasound have been repeatedly demonstrated to improve postnatal outcomes (Bahtiyar & Copel, 2015), and this imaging modality can now be applied for creating 3D printed models.

3D printed models of fetuses have already been created from 3D ultrasound data that have provided very good impressions of the face, ears, hands, and feet (Werner et al., 2010) (Fig. 12). The same process can be used to create 3D printed models of fetal cardiac anatomy, especially with the advances in 3D fetal cardiac ultrasonography.

Fig. 12: 3D ultrasound to 3D print of a fetus. Left: 3D ultrasound of a normal fetus at 26 weeks gestation. Middle: mathematic 3D virtual image. Right: physical model printed in a power-based system (figure from Werner et al., 2010).

Manufacturers of ultrasound machines have recently started to incorporate export options in file formats that support 3D printing. GE’s new Voluson E10 model is the first commercially available scanner of its kind that can export in multiple file formats compatible with 3D segmentation software, such as DICOM and Cartesian .vol files (General Electric Company, 2017). The Voluson E10 also
supports new rendering technologies that offer unprecedented image detail and clarity in less time, facilitating new opportunities to create novel visualizations derived from fetal ultrasound that can potentially be used for clinical and surgical applications.

**POST-PROCESSING OF IMAGING DATA**

The second step in the 3D printing workflow after imaging data are acquired is image segmentation, which refers to the delineation of the desired anatomy, or region of interest (ROI). Discrimination of the anatomy of interest from surrounding tissues often requires expertise and time, and knowledge of specialized software is needed to perform the segmentation. Segmentation may take 2–3 hours, but differs significantly depending on the region of interest. Some software options do, however, offer algorithms and protocols that are tailored for more efficiently defining certain anatomical regions. No standardized approach to image segmentation currently exists, and the segmentation process can be automated or manual, but many workflows promote a semi-automated approach. The most common approach involves automated brightness thresholding and region growing, followed by manual editing (Byrne et al., 2016). Thresholding is a method in which voxels—which are 3-dimensional pixels representing a very small cube of the scanned anatomy—are partitioned based on their intensity or brightness value. Region growing evaluates the relationship of neighboring voxels to an initial seed point and determines whether those adjacent voxels should be included as part of the region. Manual editing may be necessary to smooth, crop, or repair the results of the segmentation.

In order to create a model that a 3D printer will recognize, DICOM data from a CT, MRI, or ultrasound scan must first be converted to surface mesh polygons. Volumetric data from DICOM files are stored as voxels, but 3D printers do not interpret voxel data; instead, the file must be converted to vector shapes or polygons (usually triangles) that define the outer surface of the ROI volume. During the segmentation process, the boundaries of the ROI are outlined on successive 2D slices that are subsequently assembled to create a 3D model (not unlike slices of bread creating a loaf), and the outer ‘shell’ of the model is comprised of a surface mesh of small polygons. The most common file format for this mesh is StereoLithograph, also known as Standard Tessellation Language (STL). 3D printers reinterpret data in an STL file to manufacture a physical object.
Introduction

Cartesian DICOM

For both CT and MRI DICOM data, the voxels are represented in a Cartesian system, and the segmentation process for either imaging modality is identical. Positions in a Cartesian coordinate system are defined by three numerical coordinates, which are the distances from a point to three fixed perpendicular lines in the x, y, and z planes originating for a reference point (the coordinates are therefore delineated as (x, y, z)) (Fig. 13). Most existing segmentation software can only read DICOM files in which the voxels are defined by Cartesian coordinates.

There are a number of segmentation software options currently available for Cartesian DICOM data sets. Considerations when choosing software include cost, platform availability, auto-segmentation protocol options, ease of use, and FDA clearance. The FDA has approved more than 85 devices associated with 3D printing, including some post-processing software for medical imaging data, which have been cleared for clinical use (TeraRecon, 2017).

A 2016 study by Byrne et al. reviewing image segmentation methodologies used in 3D printed cardiovascular models found that the most popular image segmentation software reported in the literature to date was Materialise’s Interactive Medical Image Control System (Mimics) (Materialise NV, Leuven, Belgium). Other proprietary post-processing software options include: inPrint (Materialise NV, Leuven, Belgium); Vitrea (Vital Images, Inc., Minnetonka, MN); OsiriX MD (Pixmeo, Geneva, Switzerland); Carestream Vue PACS (Carestream Health, Inc., Rochester, NY); and D2P (3D Systems, Rock Hill, SC). Free, open source software is also available, and includes 3D Slicer (www.slicer.org), ITK-SNAP (www.itksnap.org), and Horos (Purview, Annapolis, MD), among other options.
Non-Cartesian DICOM

Due to the nature of the acquisition, native 3D ultrasound data are expressed as voxels that are represented in a non-Cartesian system (e.g. a spherical coordinate system, in which the voxel is defined as a distance from a reference point and two angles; coordinates are delineated as \((r,\theta,\phi)\)) (TomoVision, 2017) (Fig. 13). DICOM currently only supports voxels in a Cartesian system, and most post-processing software cannot handle ultrasound data. In order to use ultrasound data for 3D model creation, a couple of different options exist.

One option is to convert the data to a “Cartesian” file, which requires specialized software. For instance, data from Philips brand devices must first be uploaded to a cardiovascular ultrasound quantification software called QLAB (Philips Medical Systems, Andover, MA). At this point, only the research edition of Mimics can support this exported file type (it can also support “Cartesian .vol” files exported from GE machines). Another option is to use software that is capable of reading the native ultrasound file. Software called Baby SliceO (TomoVision, Inc., Magog, QC, Canada) is capable of reading 3D ultrasound files and generating STL print-ready models directly from the data sets. Baby SliceO is compatible with DICOM data, as well as native proprietary formats such as .vol files from GE ultrasound machines and .mvl and .vff files from Samsung ultrasound machines (Fig. 14).

Fig. 14: Baby SliceO by TomoVision is an option for handling ultrasound data (text not intended to be read).
Baby SliceO is primarily used for segmenting external anatomy (like a fetus’s facial features) and not designed for segmenting fetal cardiac anatomy, because the heart structures are internal. Finally, a company called In Utero 3D also developed their own proprietary software to convert ultrasound data from several device brands including GE, Hitachi, Siemens, and Samsung into 3D printable STL models. The software itself is unavailable for commercial purchase, but they offer ultrasound data to STL conversion services (Votrex, 2017).

Mesh Clean Up

At this point, most STL files generated directly from the segmentation step require some additional optimization or clean up. Computer-aided design (CAD) software is used to refine the STL file, and the necessary CAD functions required depend on the outcome of the segmentation and the intended use of the model. Common CAD manipulations include smoothing or wrapping, patching, surface mesh topological correction, trimming, adding connectors such as cylinders between separate anatomical regions, or hollowing. In cardiovascular applications, the hollowing function is crucial in cases in which a blood pool (the volume within a vessel or chamber of the heart obtained using a contrast agent) was segmented. In such instances, a vessel wall of a given thickness must be generated to encompass the volume defined by the blood pool. In general, solid models provide insights into details of the anatomy, whereas hollow models are useful for simulating surgical steps (Kiraly et al. 2016). Labeling the part is an important consideration to assure traceability as well.

Some of the before mentioned segmentation software—including Mimics, inPrint, Vitrea, and D2P—do offer some additional post-processing functions within the same software interface. Additional software called 3-matic (Materialise NV, Leuven, Belgium) can perform a range of useful operations, including mesh analysis and refinement to ensure printability, as well as custom design of implant and surgical guides. This software is also FDA certified for clinical use. It is worth noting that any manipulation of an STL mesh outside of FDA cleared software can void the certification.

Additional manipulations of the 3D model can be made in a range of other 3D mesh and modeling software. Some options include: Meshmixer (Autodesk Inc., San Rafael, CA); MeshLab (meshlab.
Introduction

of these listed, Meshmischer, MeshLab, and Blender are free options.

GENERATION OF 3D PRINTED MODELS

The final step of the 3D print workflow is the actual physical printing of the model. Options for 3D printing hardware, materials, and post-print processing are important to evaluate. Factors to consider when selecting a 3D printer include: cost, the type of technology used to print, material options, print resolution, time (required to set up the print job, actual time to print the model, and post-processing clean up time), ease of use, and required maintenance. Print resolution is especially important when planning models of extracardiac vessel anatomy; the thickness of a newborn’s aorta is only about half a millimeter (Sodhi et al., 2015), and the heart itself is only about the size of a large walnut. Factors to consider when selecting materials include: physical and mechanical properties, flexibility, color, transparency, biocompatibility, cost, recyclability, durability, and tackiness. Post-print processing considerations include: ease of cleaning and removing of support materials, clarity of finished clear pieces, tear strength of flexible materials, and sterilizability.

Overview of Printer Types

The most commonly reported 3D printing technologies used for cardiovascular applications include Fused Deposition Modeling (FDM), Selective Laser Sintering (SLS), Stereo Lithography Apparatus (SLA), and Multi-Jet Printing (MJP), which are described below (Giannopoulos et al., 2016):

FDM (material extrusion): The print materials are softened with heat, extruded layer by layer on a build tray, and immediately solidified to create the object. Plastics such as acrylonitrile butadiene styrene (ABS) or polylactide (PLA) are used to create sturdy, durable models in a fairly short time period. FDM is the most popular cardiovascular 3D printing technology due to its lower cost and shallow learning curve, but the finish quality and resolution of the prints are also lower compared with other technologies. Typical consumer FDM printers have a layer thickness of 0.2–0.3 mm, though higher end models can support a vertical resolution of 0.02 mm.
**SLS** (powder bed fusion): SLS uses an energy source, such as a high power laser, to selectively sinter (fuse) successive layers of a powdered material. Supports are not required and a variety of materials can be used, such as plastic, glass, ceramic, and metal. SLS is ideal for sterilizable metal implants. Hardware and material costs are high, and printer handling and maintenance requires training. Typical layer thicknesses of SLS printers range from 0.08–0.15 mm.

**SLA** (vat photopolymerization): in SLA printing, layers of photosensitive liquid resin in a vat are hardened using a high-intensity UV light source. Successive layers of liquid are exposed to the UV light and solidified as the vat is lowered or raised following the build tray movement. The resulting model is cured with UV light. SLA models have high accuracy with smooth finishes, but materials are expensive and not durable over time. SLA models are good for surgical planning and simulation. SLA printers can print with a layer thickness as thin as 0.025 mm.

**MJP**: Printer jet heads deposit an acrylic photopolymer onto a build tray that is cured with UV light. Wax or gel support holds together the layers of the build polymer. MJP hardware and materials are expensive, but allow for versatile, multicolored prints. MJP is the highest-precision 3D printing technique, and the ability to mix materials with different properties allows for models with variable rigidity, enabling a more realistic recreation of the physical properties of human anatomical models. At its highest resolution, MJP printers can build in layers as thin as 0.016 mm.

At Johns Hopkins, a Stratasys Connex3 Objet260 printer, a type of PolyJet (very similar to MJP) printer, was used to create the 3D prints for this project. This printer is capable of printing layer thickness as low as 0.016 mm and excellent for producing fine feature details.

**Material Considerations for Surgical Planning**

A variety of materials are used in medical 3D printing, ranging from plastic (resin) to nylon and even metals. A major advance in cardiovascular 3D printing applications in particular has been the ability to print in transparent, flexible material. Flexible models can be bent and cut, enabling assessment of the pathology and selection of ideal viewing planes for complex cases. Pliable materials have been used to create vascular models for catheter-based interventional planning, and 3D printed CHD...
models in flexible material have allowed hands-on training of surgical repair, including suturing of the cardiac defects (Giannopoulos, 2016). Improved material transparency and softness facilitates elevated comprehension of complicated 3D anatomy of soft tissues, and allows for the creation of effective pre-planning simulators (Kim et al., 2016).

THE ROLE OF MEDICAL ARTISTS IN CREATING 3D PRINTS

The rise in 3D segmentation and printing technologies have highlighted a growing need for trained biocommunicators to bridge the gap between raw imaging data sets and polished, high-fidelity 3D printed models. Medical illustrators/artists possess a unique background rooted in scientific and medical knowledge paired with wide-ranging artistic and technical expertise, which can be applied to creating refined, customized visualizations and 3D printed models.

DESIGNING A CUSTOM MODEL FOR HLHS SURGICAL PLANNING

In order to create a 3D model that is optimized for surgical planning, proper surgical view is of primary importance. The pre-operative HLHS aortic arch model can be positioned using customized supports that place it in the appropriate surgical view (the Norwood procedure is done through a median sternotomy, and so the surgical approach is from the anterior side of the patient). In another step beyond the conventional workflow for creating a 3D anatomical model, the steps of the Norwood procedure itself can be recreated digitally using 3D modeling software to manipulate the pre-operative HLHS model, to create an approximation of the desired surgical outcome customized to the specific arch anatomy. The shape of the necessary homograft can then also be defined, and printed separately using a flexible material to help surgeons visualize a patient-specific shape of the homograft patch needed to reconstruct the aorta. When made using a flexible 3D print material, the HLHS model allows the surgeon to actually simulate suturing the 3D printed homograft to the 3D printed HLHS aortic arch anatomy. 3D printed models created for surgical planning, as well as simulation, have the potential to reduce procedure time—which would lower operating room costs—and improve patient outcomes from more streamlined surgeries.
OBJECTIVES

The intended outcomes of the project were to create:

1. Life-sized 3D printed model of pre-operative aortic arch anatomy of HLHS
2. 3D printed model approximating the desired post-operative aortic arch anatomy
3. 3D printed customized shape of the homograft patch used in surgical aortic arch reconstruction of HLHS
4. Proof of concept models created from 3D cardiac ultrasound and 3D fetal cardiac ultrasound data
5. A reproducible workflow, detailing the steps involved in achieving the above objectives, from imaging data acquisition and segmentation/post-processing, to digital modeling and 3D printing

The workflow will address benefits and drawbacks of different segmentation software, digital modeling options, and print material considerations, taking into account availability, ease of use, and cost. It will be designed to accommodate scenarios in which CT or MRI data is unavailable, taking into account different ultrasound derived options.

The target audience for the 3D printed models are pediatric cardiothoracic surgeons planning interventions in infants with HLHS. The 3D printed model approximating the desired reconstructed aortic arch will further help surgeons conceptualize the specific shape of the homograft needed to reconstruct the aorta. The workflow is intended for surgeons, 3D technicians, and medical artists looking to create patient specific 3D printed heart models for use in surgical planning.

A MULTIDISCIPLINARY COLLABORATIVE APPROACH

Management of CHD patients requires a multidisciplinary team, and medical artists can play a key role in assisting with the creation of 3D printed heart models that can enhance communication and preparedness within the team. Effective collaboration was an essential component to the success of
this project, and the combined expertise of multiple specialists—including surgeons, cardiologists, radiologists, sonographers, obstetricians, and 3D software experts—was key for ultimately proposing a solution to this visual problem.
MATERIALS AND METHODS

In order to create the HLHS pre- and post-op models, CT data were used. As discussed previously, patients with HLHS typically do not get CT or MRI scans prior to stage I palliation. No existing pre-op CT scans of HLHS patients were available at Johns Hopkins. A model derived from a post-Norwood CT scan was therefore manipulated to recreate the pre-operative model. The steps involved will be subsequently outlined.

In addition, 3D ultrasound and 3D fetal ultrasound data were used to create proof of concept models. (A proof of concept is a realization of a particular method to demonstrate its feasibility, to verify that the concept has the potential of being used in other applications.) In this case, 3D ultrasound data of the aortic arch, as well as 3D fetal ultrasound data of a normal fetal heart, were used to create models. The same steps could, in theory, be applied to HLHS patients in the future, and manipulated to be used for surgical planning. The steps involved will also be outlined.

CARDIOVASCULAR IMAGING DATA ACQUISITION

All of the imaging data were acquired at the Johns Hopkins Hospital and exported appropriately for use in segmentation software.

CT

Use of CT data for this project was covered under IRB # CIR00023207, “Change in Research for NA_00001068 Parent Study: Review of Outcomes Following Cardiac Surgical Procedures at Johns Hopkins Hospital and Washington University.” A CT Angiography with IV contrast DICOM data set for a post-Norwood HLHS case was identified and obtained from a radiologist at Johns Hopkins. A SOMATOM Definition Flash CT Scanner (Siemens, Munich, Germany) was used, and the slice thickness was set to 0.75 mm. The data were exported in DICOM format and subsequently imported into segmentation software.

3D ULTRASOUND

3D ultrasound imaging acquisition of the aortic arch (from the suprasternal notch window) was
performed on an adult female using an X5 transducer on a Philips EPIQ 7 ultrasound system (Philips Medical Systems, Andover, MA). The data set was then brought into Philips QLAB (Philips Medical Systems, Andover, MA), an ultrasound quantification software. In QLAB, the “Enable Cartesian Export” option under preferences was selected, and the data set was converted and exported as a 3D “Cartesian DICOM” file (Fig. 15).

![Fig. 15: QLAB interface with export options (text not intended to be read).](image)

After conversion to Cartesian format in QLAB, the DICOM data set was then imported into Mimics (Materialise NV, Leuven, Belgium) for segmentation of the aortic arch.

### 3D FETAL ULTRASOUND

To create a 3D model of a fetal heart, 3D fetal ultrasound data were obtained from a Voluson E10 ultrasound machine (GE Healthcare, Chicago, Illinois). The data set used was obtained from a set of sample image scans provided by GE. A 3D/4D GE RM6C ultrasound transducer was used to scan the heart of a fetus at 27 weeks gestational age, using STIC settings. The data set was exported directly from the Voluson E10 as a “Cartesian .vol” file, and ready to be imported as is into Mimics for segmentation.
POST-PROCESSING OF IMAGING DATA

In the next step of the 3D printing process, the acquired imaging data had to be post-processed, starting with segmentation. The steps for segmenting CT and ultrasound data will be addressed.

SEGMENTATION OF CARTESIAN DICOM – CT

Although several software options are currently available for segmentation, this project focused on evaluating the following six: Mimics, inPrint, Vitrea, OsiriX MD, D2P, and 3D Slicer. The boundaries of the CT segmentation were verified by a radiologist. Other segmentation software options, including Caresteam Vue PACS, ITK-SNAP, and Purview Horos were considered but not used for this project. The same post-Norwood HLHS CT data set was used in each of the following segmentation software options. Much of the workflow for each software used similar tools, like thresholding and 3D volume cropping, but the interface, navigation, and other factors differed.

Mimics

Materialise’s Interactive Medical Image Control System (Mimics) (Materialise NV, Leuven, Belgium) is a software tool for visualizing and segmenting medical images and rendering 3D objects. Mimics comes in a medical edition—which is FDA cleared for “treating and diagnosing patients, planning surgeries and interventions, and rehearsing operations”—and a research edition. Materialise software is available for PCs only. The CT data set was first anonymized by going to File > Anonymize Project. The “CT Heart Segmentation” option under the “Cardiovascular” tab was chosen, which brought up a “Thresholding” tool. The minimum and maximum threshold values were selected based on the voxel values of cardiac blood pool (Fig. 16).

The threshold values at this point still included some unwanted anatomy (bones, wires, etc.), so the “Crop Mask” tool was used to isolate the heart (Fig. 17).
After cropping, the “3D preview” option was selected in the 3D toolbar next to the 3D viewport. With the 3D preview on, the “Edit Mask” tool from the “Segment” menu was used to edit the mask in 3D. The “Lasso” tool was used to erase out unwanted anatomy in the 3D view. Once the mask satisfactorily included only the region of interest, the “Calculate 3D” option was selected to generate the 3D Object (Fig. 18). The calculated 3D Object represented the actual three-dimensional mesh file derived from the mask.
In Mimics, the 3D Object could be further refined. A “Smooth” function was applied to decrease the roughness of the model and eliminate the pixelated look of the initial 3D Object (Fig. 19). After smoothing, the 3D object was exported as an STL file, finishing the segmentation step.

**inPrint**

Materialise also offers a software package called inPrint (Materialise NV, Leuven, Belgium), which is designed to be workflow-oriented to accommodate efficient segmentation and model creation in a hospital setting. InPrint offers dedicated semi-automated segmentation tools for cardiac, orthopedic, and other applications, and allows the generation and manual editing of regions of interest (ROI) through intuitive editing. Representatives at Materialise allowed the author to use the beta version of inPrint 2.0, which includes additional tools such as the 3D interpolate tool, a separate hollow tool, export part multicolor function, and other tools.

The designated workflow in inPrint consists of the following sequential steps: (1) Create ROI, (2) Edit ROI, (3) Add Part, (4) Edit Part, and (5) Prepare Print (Fig. 20).

The first step in the inPrint workflow was creating the ROI, which was done through thresholding by choosing the values corresponding to the cardiac blood volume, under Create ROI > Guided Segmentation > Thresholding (Fig. 21). It is also worth noting that under the Guided Segmentation menu, there is a “Heart tool,” which guides the user through a process of placing “seed points” to delineate the aorta, pulmonary artery, and the four chambers of the heart to create separate ROIs of the main cardiac regions.

In the second step, the ROI was edited by using tools under the “Edit ROI” tab—such as the “Brush,” “Lasso,” and “Isolate” tools—to erase unwanted anatomy from both the 2D and 3D views, effectively isolating the cardiac blood pool (Fig. 22).
In the third step, a hollowed 3D model was created from the ROI (Fig. 23). The first version of inPrint limited the thickness of the hollowed walls to no less than 1.5 mm. In inPrint 2.0, the thickness could be manually adjusted to be thinner than 1.5 mm.

In the fourth step, the “Fix Wall Thickness” option was selected (Edit Part > Edit > Fix Wall Thickness) to automatically repair the walls of lumens that were very close together. Additionally, the “Cut” tool was used to crop the model (Edit Part > Separate > Cut); finally, in the fifth step the
Materials and Methods

32

Fig. 24

OsiriX MD

OsiriX MD (Pixmeo, Geneva, Switzerland) is a widely used DICOM viewer, and offers 3D segmentation tools for creating 3D printable models. It is available only for Mac OS X. It can be configured to be integrated with a PACS system, and is FDA cleared for diagnostic imaging in medicine and certified for medical use. Pixmeo also offers a free version called OsiriX Lite, which has the same functionality as OsiriX MD but lacks FDA clearance.

DICOM data brought into OsiriX MD were first anonymized, by right clicking the data set in the home page and choosing “Anonymize.” This brought up a menu, in which individual metadata tags with patient identifying information, such as patient name, age, and medical record number, could be manually selected and de-identified. In order to create a cardiac model, a region of interest (ROI) was first defined in OsiriX under ROI > Grow Region (2D/3D Segmentation). In this menu, the completed model was exported as an STL file (Fig. 24).
“Threshold (upper/lower)” algorithm under the “3D Growing Region” parameter was chosen, and an upper and lower threshold value were chosen based on the voxel values in the blood pool (Fig. 25).

After the ROI was defined by the threshold values, the next step was to choose “Select Pixel Values to…” under the ROI menu, and to set the value of the pixels “Outside ROIs” to -3,024. This cleared the anatomy outside of the ROI. To create a volumetric model from the defined ROI, the 3D Viewer > 3D Volume Rendering option was selected. The unwanted anatomy from the resulting 3D reconstruction was erased out using the “Scissors” tool (Fig. 26). Once the 3D volume was cleaned up, 3D Viewer > 3D Surface Rendering was selected to generate a 3D surface rendering of the model, which was exported as an STL file.

**Vitrea**

Vitrea (Vital Images, Inc. Minnetonka MN) is a multi-modality visualization system that offers a
Materials and Methods

A number of advanced imaging tools that can be applied for clinical use. Although its primary purpose is not for 3D printable model creation, Vitrea offers tools designed for 3D printing purposes; some of the more specialized tools were not available on the version of Vitrea used in this project, but the basic functions were sufficient to export out an STL file from DICOM data (Fig. 27).

Once the DICOM file was loaded into Vitrea, the Segment Anatomy > Vessels > Grow tool was used to select a region within the blood pool (Fig. 28).

Clicking and dragging within that region expanded the connected blood pool anatomy, and was repeated until the entire blood pool was selected (Fig. 29).

This process selected some unwanted anatomy, so under Segment Anatomy > Sculpt, the Multi-Slice tool was used to select and remove the unwanted regions; once the all the unwanted anatomy was manually removed, the final model was exported as an STL (Fig. 30).
D2P

D2P (3D Systems, Rock Hill, SC) stands for “DICOM-to-Print,” and is marketed as a stand-alone modular software packaged designed to consolidate all 3D model preparation steps in an efficient manner. Automatic tools are intended to allow for 3D model segmentation with minimal time and effort. The software targets medical staff for preoperative surgical and procedural planning, surgical simulation, and pre- and post-operative debriefing. The software is currently unavailable on the market, and the software is available only for Windows. The representatives at 3D Systems allowed the author to evaluate the beta version of the heart segmentation tool, which was used to segment the HLHS post-op CT data.
DICOM data were imported into D2P, and the “Anonymize” function was selected in the home screen to remove patient identifiers from the imaging data. The “Cardiac Segmentation” tool was used to segment the CT data. The first step to using this tool was to crop the boundaries of the anatomy to only encompass the heart (Fig. 31).

After cropping, the following selection was prompted, from Cardiac Segmentation > Chamber > Select Markers. The markers were placed in regions corresponding to the pulmonary artery, aorta, left ventricle, left atrium, right ventricle, and right atrium, in the full screen axial view (Fig. 32). (Note: this is process of segmentation is very similar to the “Heart tool” in inPrint.)

Clicking “Set” after the markers were placed resulted in the automatic generation of the 3D mask delineating the cardiac anatomy (Fig. 33).
To remove the unwanted geometry resulting from the mesh, the “Scissors” tool was used (Fig. 34).

Once the mesh was appropriately cleaned up, the “3D” option was selected to generate the 3D surface mesh of the entire blood pool as a solid model (Fig. 35). Entering “Control + Shift + H” was an option to create a hollow model, but this function was still being worked out in the beta version of the “Cardiac Segmentation” workflow. The STL of the resulting mesh was exported from the home page of the D2P software.

Although not utilized in this research project, D2P is also compatible with virtual reality applications, and may be of interest in a future endeavor.
3D Slicer

3D Slicer (www.slicer.org) is a free, open source software platform for medical image informatics, image processing, and three-dimensional visualization that is available for Windows, Mac OS X, and Linux. It was developed over two decades through support from the National Institutes of Health. Slicer was created to provide free, powerful cross-platform processing tools to physicians, researchers, and the general public. It allows segmentation of medical images, and plug-ins can be installed for added algorithms and applications. There is no restriction on use, but Slicer is not approved for clinical use and intended for research only.

In order to create a 3D printable model in 3D Slicer (v. 4.6), the Module > Segment Editor > Add Segment option was chosen after importing the DICOM data set. Much like the other segmentation software, a threshold value for the blood pool was first defined (Effects > Threshold), and then the “Scissors” and “Eraser” tools (also under the Effects menu) were used to discard the unwanted anatomy and create the final model (Fig. 36).

**Fig. 36:** 3D Slicer interface and completed segmentation (text not intended to be read).

SEGMENTATION OF NON CARTESIAN DICOM – ULTRASOUND

Mimics was chosen for the ultrasound data segmentation. Only the research version of Mimics can handle ultrasound data, and only from GE and Philips machines. The 3D ultrasound data of the
aortic arch obtained for this project was from a Philips scanner, and the 3D fetal ultrasound data was from a GE scanner. During the ultrasound data segmentation, the boundaries of image data were verified by a sonographer.

3D Ultrasound

The “Cartesian DICOM” file of the 3D ultrasound data of the aortic arch was imported into Mimics. When opening the file in the New Project Wizard, the “Non-strict DICOM 3.0” option was selected under “Import Method.” After the data set was loaded, the orientation for the ultrasound data had to be designated (Fig. 37).

![Change Orientation](image)

Fig. 37: Setting the orientation for 3D ultrasound data (text not intended to be read).

In order to segment the ultrasound data, a threshold value was chosen, and the unwanted voxels from the mask were removed using the “Eraser” tool. Then, the “Multiple Slice” edit tool was used to apply the threshold to just the aortic arch anatomy, using the “Interpolate” option to apply the threshold values to multiple slices at a time, to complete the segmentation (Fig 38).
After the segmentation was completed, the “Calculate 3D” option was selected to generate the 3D Object, which was smoothed out and subsequently exported as an STL file (Fig. 38).

### 3D Fetal Ultrasound

The 3D fetal cardiac ultrasound data was imported into Mimics in the same manner as the 3D ultrasound data described above; the orientation for this data set had to be reconfigured as well (Fig. 39).

For the fetal cardiac ultrasound data, a threshold value was chosen to include the cardiac blood pool, and then cropped and edited with the “Edit Mask” tool in the 3D preview mode to isolate the cardiac anatomy. The “Lasso,” “Region Grow,” and “Multiple Slice” tools were used to refine and finish the segmentation (Fig. 40).

The mask was then calculated as a 3D Object, smoothed, and exported as an STL file (Fig. 41).
Materials and Methods

Fig. 40: Setting the orientation for 3D fetal cardiac ultrasound data (text not intended to be read).

Fig. 41: Finished segmentation of the fetal cardiac blood pool.
MESH CLEAN UP

The STL files that were exported from the segmentation software were brought into Meshmixer (Autodesk Inc., San Rafael, CA) to evaluate and repair the mesh for 3D print preparation. The “Inspector” tool (Analysis > Inspector) in Meshmixer was primarily used to create 3D print ready models (see Results). STL file refinement, including smoothing, trimming, patching, etc. was also possible using 3-matic (Materialise NV, Leuven, Belgium). Segmentation results from Mimics could also be directly exported to 3-matic (File > Export > 3-matic), and once in 3-matic, the models could also be exported as a 3D PDF file (File > Export > 3D PDF) (Fig. 43).

MODEL OPTIMIZATION

In order to design 3D printable HLHS pre-op, HLHS post-op, and homograft models optimized for surgical planning and simulation, factors such as print thickness and orientation had to be considered.
Materials and Methods

Determining Limits of Print Thickness

As discussed previously, the thickness of neonatal aorta is roughly half a millimeter (Sodhi et al., 2015). In order to print out models that are anatomically faithful, the resolution of the Stratasys Connex3 Objet 260 printer available at Johns Hopkins had to be tested to determine how thin a hollow model could be printed. Thicknesses of less than 1.5 mm are generally not recommended when using flexible Tango Plus print material and the SUP706 support material, but this exploration sought to test the limits of the claim. Two aortic arch models—one simulating the pre-op HLHS aortic arch anatomy and the other representing a post-op neoaorta after the Norwood—were created using the post-op HLHS CT data provided (Fig. 44).

Once the shells of the models were created, different thicknesses were applied to the aortic arch models using the Select > Edit > Extrude function in Meshmixer (Fig. 45). The “Offset” value determined the thickness, and the “Direction” type had to be set to “Normal” in order for the extrusion to be applied uniformly to the model.

The offsets, or thicknesses, were set to 0.8 mm, 1.0 mm, 1.3 mm, and 1.5 mm (Fig. 46). To crop the ends of the models, the Edit > Plane Cut tool was used. These models were then exported as an STL and sent to the Stratasys

Meshmixer was used to manipulate the 3D STL files exported from the segmentation software.
Materials and Methods

printer to evaluate the feasibility and durability of the models.

Once it was determined from this test that hollow models as thin as 0.8 mm could be successfully printed, the HLHS models were created. Two more experimental models were printed at 0.7 mm and 0.6 mm wall thickness. At a 0.7 mm wall thickness, the model was still sturdy enough to withstand post-print processing, but at 0.6 mm, the walls were too fragile and tore too easily (see Results).

PRE-OP HLHS MODEL

Because no pre-op CT scan of HLHS anatomy was available, a model was created by “undoing” the Norwood operation on the post-op CT scan model (Fig. 47). This was done in part by using the 2D ultrasound measurements that were taken of the pre-op HLHS heart anatomy, which gave the diameters of the aorta and pulmonary arteries.

Once the pre-operative anatomy was reconstructed, the portion including just the ascending aorta, aortic arch, main pulmonary artery, and PDA was isolated, since that was the region of interest for the Norwood operation (Fig. 48). The

Fig. 47: Creating a pre-op HLHS model by “undoing” the Norwood operation. Left: The connected portion from the base of the main pulmonary artery and descending aorta are divided. Middle: the MPA (purple) is reconstructed and reconnected to the right and left pulmonary arteries. Right: the hypoplastic aortic arch has been reconstructed and reattached.

Fig. 48: Pre-operative HLHS aortic arch anatomy (left). The right model has a thickness of 0.7 mm applied.
Materials and Methods

Wall thickness of the vessel anatomy was set at 0.7 mm, which was determined to be the thinnest possible print for a hollow model.

Next, to create an HLHS model that would be placed in the proper anatomical orientation a surgeon would view during the Norwood operation (Fig. 49), supports were created to place the aortic arch and pulmonary artery in AP view, as they would be accessed through a median sternotomy.

![Fig. 49: Surgical view during the Norwood operation. The cardiac anatomy is viewed from a median sternotomy. (Left screen shot from youtube.com/watch?v=8VPhqo5uepo; right screen shot from youtube.com/watch?v=tdoN4F0kdoL.)](image)

In Meshmixer, the “Boolean” and “Weld” operations were used to seamlessly connect the supports to the aortic arch model (Fig. 50). The lumen was left patent.

![Fig. 50: Creation of support walls in Meshmixer (text not intended to be read). Left: aortic arch model and support walls placed in position. Middle: using the “Weld” tool to seam the boundaries of the aortic arch model and supports. Right: finished pre-op HLHS model with supports.](image)

**APPROXIMATED POST-OP HLHS MODEL**

In addition to creating a pre-operative model, a post-operative model was also created in Meshmixer, in order to determine the approximate shape and size of the homograft used for the Norwood repair. Taking the pre-operative anatomy mesh, cuts were made mimicking the steps of the Norwood operation (Fig. 51).
The “Warp” tool (Select > Deform > Warp) was then used to open the model (the “Warp” tool moves vertices in the mesh without changing their connectivity, and allows manipulation of geometry without adding or subtracting polygons to the mesh). The resulting gap between the aortic arch and cut edge of the MPA was filled with the “Bridge” tool (Select > Edit > Bridge) and the “Inspector” tool (Analysis > Inspector) (Fig. 52).

The selected area in the post-op model representing the homograft patch was then isolated and extruded, so that the boundaries of the homograft could be seen on the printed post-op model (Fig. 53).

Fig. 51: Cuts made to the pre-operative model to mimic the steps of the Norwood operation. Left: cutting the MPA and PDA. Right: cutting open the underside of the aortic arch.

Fig. 52: Manipulating the geometry with the “Warp” tool (left) and filling in the resulting gap with a “homograft” mesh (in green) (right).

Fig. 53: Designation of the homograft on the post-op model (tan, on the right) and extruded (blue, on the left). The yellow arrow points to the coarctation (or vessel narrowing) that was inadvertently left unrepaired.
Additionally, a second version of the post-op HLHS model and homograft had to be created, since the first patch inadvertently left the coarctation and did not account for its repair (see arrow in Fig. 53). The incision made under the aortic arch in the first model should have gone a little further distally, and was corrected accordingly in the revised version of model (see arrow in Fig. 54). Interestingly, this is a common issue that can happen during the Norwood repair; fortunately, the operation could be corrected digitally the second time around.

**Fig. 54:** Second version of the homograft patch created. Left: incision made farther past the coarctation. Right: completed post-op model with homograft, this time without the coarctation. The green arrow points to the extended incision under the aortic arch, which allowed for the coarctation to be repaired in the second version of the model.

**HOMOGRAFT MODEL**

The part of the mesh in the post-op model representing the homograft was isolated (Fig. 55), and given a 0.8 mm thickness for 3D printing.

**PULMONARY ARTERY MODEL**

A pulmonary artery model was also created, since surgeons at Johns Hopkins prefer to use a pulmonary artery homograft to create the homograft patch used during the Norwood procedure. A normal adult heart was segmented from sample CT data provided by 3D
Materials and Methods

Slicer, and the pulmonary artery was isolated, optimized, and prepared for printing (Fig. 56).

**ADDITIONAL HYPOPLASTIC AORTIC ARCH MODEL**

In order to illustrate the wide variation in aortic arch anatomy, a second hypoplastic aortic arch model was created. The CT data set of a CHD case in which the aortic arch was hypoplastic was chosen as the basis for this second model, and created in the same fashion as the first HLHS model (Fig. 57).

**3D ULTRASOUND MODEL**

The 3D ultrasound derived aortic arch model was also brought into Meshmixer, and the geometry was further smoothed out and optimized using sculpting tools (Fig. 58). The wall of the aortic arch was
given a thickness of 2.11 mm, since the mean aorta thickness in adults is 2.11 mm for women and 2.32
mm for men (Li et al., 2004), and the model was derived from a woman.

![Ultrasound derived aortic arch model. Left: aortic arch model smoothed out; middle: model with lumen cut out; right: model with 2.11 mm thickness applied.](image)

**3D FETAL ULTRASOUND MODEL**

The 3D fetal ultrasound STL model exported from Mimics was also opened in Meshmixer, and the
geometry was further smoothed and refined using sculpting tools (see Results).

**GENERATION OF 3D PRINTED MODELS**

After verifying/optimizing the models in Meshmixer, the STL files of the 3D models were exported
and sent to a 3D printer for the final step of the 3D printing process.

**PRINTER USED AND SETTINGS**

A Stratasys Connex3 Objet260 printer (a PolyJet, or type of Multi-Jet, printer) at the Johns Hopkins
Carnegie Center for Surgical Innovation was chosen to 3D print all of the models. The models
were printed in single material mode and the printer was set for matte printing. Matte printing was
preferred over gloss to provide a more uniform finish of the print material. The print material chosen
was Tango Plus, a clear, flexible material. For the support, a soluble SUP706 material was selected.

**POST-PRINT PROCESSING**

After printing, the models were encased in the SUP706 support material (Fig. 59), a soluble gel-like
material which had to be carefully removed to expose the delicate printed portions.
Rather than using the WaterJet system provided by Stratasys, which tends to have an overly powerful water pressure that can damage thin, fragile prints, a Waterpik water flosser was used to successfully remove the gel-like SUP706 support material from inside the lumens of the prints (Fig. 60).

At the recommendation of Stratasys technical support, the models were submerged in a 2% NaOH solution for about 45 minutes to an hour, to help dissolve and clean any residual SUP706 support material (Fig. 61).
SURGICAL SIMULATION

Once the 3D models were printed and cleaned, they were “operated” on by a pediatric cardiothoracic surgeon to assess the feasibility of the models for surgical simulation. The preliminary “surgery” was performed on the 0.8 mm thick pre-op HLHS aortic model, and a silicone sheet was created to be used as the homograft material (Fig. 62).

Subsequent surgical simulation was performed using the pre-op HLHS models that were designed with supports, and the custom homografts were evaluated for how successfully they reconstructed the aortic arch (Fig. 63). Both versions of the homograft patch were assessed. The Tango Plus material had some residual tackiness, so the 3D printed models were wet down during the surgical simulation to decrease the stickiness and improve ease of suturing. 7-0 Prolene monofilament sutures were used for the repair.
RESULTS

A novel workflow for the creation of custom 3D prints designed for surgical planning and simulation was developed. Several innovative solutions for producing models of pre-operative HLHS anatomy were proposed as part of this research, and involved exploring novel ways to create 3D prints from 3D ultrasound and 3D fetal ultrasound data (with prints created as proof of concept), as well as digital manipulation of available CT scans. Post-op models were also created by digitally manipulating the pre-op model, and the shape of a custom homograft designed for the Norwood surgery was also created. As part of the research to determine this workflow, digital and tangible models of the following were created: pre-operative HLHS aortic arch anatomy; approximated post-operative HLHS anatomy; the customized shape of the homograft patch used for aortic arch reconstruction; and proof of concept models created from 3D ultrasound and 3D fetal ultrasound data.

WORKFLOW

The proposed flowchart below outlines the main steps of the 3D printing workflow, and offers options for image data acquisition, segmentation/post-processing, digital model creation, and 3D printing (Fig. 64).
**Results**

**Fig. 64:** Proposed workflow for creating customized 3D printed models for surgical planning. This flowchart is specific for creating HLHS models (particularly the “Model Creation” portion), but can be modified and applied to create models of other CHDs as well. Software packages are highlighted in blue.
SEGMENTATION SOFTWARE CHART

Select factors of the six segmentation software options discussed in Materials and Methods are summarized in Table 1. These factors include platform availability (PC vs. Mac), cost, cardiology protocol options (for guided semi-automatic segmentation of cardiac anatomy), DICOM anonymization function, PACS integration, ability to support non-Cartesian files (i.e. ultrasound data), and FDA clearance. The software options were assessed with regards to printing cardiovascular models; most of the software included several other applications as well, but were not applicable to this project. Other segmentation software options, like Carestream Vue PACS, ITK-SNAP, and InVesalius, were not explored here, either due to lack of availability or time constraints.

<table>
<thead>
<tr>
<th>Company</th>
<th>Software</th>
<th>Platform</th>
<th>Cost*</th>
<th>Cadiology Protocol</th>
<th>Anonymize Function</th>
<th>PACS Integration</th>
<th>Non-Cartesian Support</th>
<th>FDA Cleared</th>
</tr>
</thead>
<tbody>
<tr>
<td>Materialise</td>
<td>Mimics</td>
<td>✓</td>
<td>$$$/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>inPrint</td>
<td>✓</td>
<td>$$$/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Pixmeo MD</td>
<td>OsiriX MD</td>
<td>✓</td>
<td>$$/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vital Images</td>
<td>Vitrea</td>
<td>✓</td>
<td>$$$/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>3D Systems</td>
<td>D2P</td>
<td>✓</td>
<td>$$$/A/P</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Open Source</td>
<td>3D Slicer</td>
<td>✓</td>
<td>0/P</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Table 1. Summarization of select factors for Mimics, inPrint, OsiriX MD, Vitrea, D2P, and 3D Slicer. *Cost – 0 for no cost, $ for tens, $$ for hundreds, and $$$ for thousands of dollars for a single license; A – Annual and P – Perpetual licensing structure. **May have PACS integration once commercially released.
SEGMENTATION RESULTS

The STL files directly generated from the above mentioned segmentation software were assessed for print-readiness in Meshmixer. The “Inspector” tool in Meshmixer (Analysis > Inspector) identifies (and repairs) three common problems in the mesh that are incompatible with 3D printing. The goal of the repair is to create a closed “watertight” mesh with no holes and no non-manifold areas, and to discard small floating components.

The “Inspector” tool identifies the three problems by color: a blue highlight indicates holes in the mesh. The auto-repair function will attempt to fill the holes using the functions of the "Erase & Fill" Tool. A red highlight indicates non-manifold, or “bowtie” vertices or edges with more than two connected triangles. The auto-repair will delete such triangles highlighted in red, and will attempt to fill the resulting hole to repair the geometry. A magenta highlight indicates small component areas, which are simply deleted during the auto-repair process. Small components, by default, are identified as having a surface area of 1% or less relative to the total model surface area.

SEGMENTATION OF CARTESIAN DICOM

The STL files directly generated from six different segmentation software options were assessed by using the “Inspector” tool (Fig. 65). The same cardiac CTA file was segmented in each software. The geometry of all six models were easily repaired by the auto-repair function.

SEGMENTATION OF NON CARTESIAN DICOM

The STL files directly generated from the segmentation of 3D ultrasound data and 3D fetal cardiac ultrasound data (both using Mimics) were also assessed using the “Inspector” tool (Fig. 66). The geometry of both models were easily repaired by the auto-repair function.
Fig. 65: “Inspector” results of exported STLs from (A) Mimics; (B) inPrint; (C) OsiriX MD; (D) Vitrea; (E) D2P; and (F) 3D Slicer. The magenta highlights indicate small component areas. The red highlights indicate non-manifold areas.
DIGITAL 3D MODELS

The following digital models were produced in this research:

- Pre-operative HLHS model (Fig. 67)
- Approximated post-operative HLHS models (Fig. 68 and Fig. 69)
- Homograft models (Fig. 70 and Fig. 71)
- Additional hypoplastic aortic arch model (Fig. 72)
- 3D ultrasound model (Fig. 73)
- 3D fetal ultrasound model (Fig. 74)
Fig. 67: Digital model: pre-op HLHS model, with supports to place the anatomy in surgical view. Left: view of model from left. Middle: anterior view. Right: view of model from right.

Fig. 68: Digital model: approximated post-op HLHS model (version 1). The red arrow points to residual coarctation after repair, which was subsequently fixed in the second version (Fig. 69). Left: view of model from left. Middle: anterior view. Right: view of model from right.

Fig. 69: Digital model: approximated post-op HLHS model, with no residual coarctation (version 2). Left: view of model from left. Middle: anterior view. Right: view of model from right.
Fig. 70: Digital model: customized homograft model (version 1). Left: view of model from left. Middle: posterior view. Right: view of model from right.

Fig. 71: Digital model: customized homograft model (version 2). Left: view of model from left. Middle: posterior view. Right: view of model from right.

Fig. 72: Digital model: additional hypoplastic aortic arch model. Left: view of model from left. Middle: anterior view. Right: view of model from right.
Fig. 73: Digital model: 3D ultrasound derived model of adult aortic arch anatomy. Left: view of model from left. Middle: anterior view. Right: view of model from right.

Fig. 74: Digital model: 3D fetal ultrasound derived model of the fetal heart at 27 weeks gestational age. Left: view of model from left. Middle: anterior view. Right: view of model from right.
3D PRINTED MODELS

The following 3D printed models were produced:

- Models created to determine print thickness limit (Fig. 75 and Fig. 76)
- Preliminary pre-operative HLHS models (Fig. 77)
- Pre-operative HLHS model (Fig. 78)
- Approximated post-operative HLHS models (Fig. 79 and Fig. 80)
- Homograft models (Fig. 81 and Fig. 82)
- Pulmonary artery model (Fig. 83)
- Additional hypoplastic aortic arch model (Fig. 84)
- 3D ultrasound model (Fig. 85)
- 3D fetal ultrasound model (Fig. 86)

The models were printed on a Stratasys Connex3 Objet260 printer, using Tango Plus material and SUP706 support material.
Fig. 75: 3D print: aortic arch models (top row: post-op; bottom row: pre-op) created to determine print thickness limit. Thicknesses of the models, from left to right, are 1.5 mm, 1.3 mm, 1.0 mm, and 0.8 mm.

Fig. 76: 3D print: cut edge view of aortic arch models (pre-op). Thicknesses of the models, from left to right, are 1.5 mm, 1.3 mm, 1.0 mm, and 0.8 mm.
**Fig. 77:** 3D print: preliminary pre-op HLHS models. Left: 0.7 mm wall thickness. Right: 0.6 mm wall thickness. At 0.6 mm, the model became too fragile and tore too easily, as shown. Printed models as thin as 0.7 mm were therefore determined to be feasible from this exploration.

**Fig. 78:** 3D print: pre-op HLHS model, with supports to place it in surgical view. A: view of model from left. B: anterior view. C: view of model from right. D: superior view. E: inferior view.
**Fig. 79:** 3D print: approximated post-op HLHS model (version 1). Left: view of model from left. Right: view of model from right.

**Fig. 80:** 3D print: approximated post-op HLHS model (version 2), with corrected coarctation repair. Left: view of model from left. Right: view of model from right.
Results

Fig. 81: 3D print: homograft model (version 1). Left: view of model from left. Right: view of model from right.

Fig. 82: 3D print: homograft model (version 2). Left: view of model from left. Right: view of model from right.

Fig. 83: 3D print: pulmonary artery model (from adult CT data).
**Fig. 84:** 3D print: additional hypoplastic aortic arch model. A: view of model from left. B: anterior view. C: view of model from right. D: superior view. E: inferior view.

**Fig. 85:** 3D print: 3D ultrasound derived aortic arch model. Left: side view; Right: superior view.
Fig. 86: 3D print: 3D fetal ultrasound derived fetal cardiac model. A: view of model from left. B: anterior view. C: view of model from right. D: superior view. E: inferior view.
SURGICAL SIMULATION RESULTS

Three rounds of “surgery” were performed on the 3D printed models. The preliminary simulation tested the feasibility of cutting into and suturing the 3D printed models. No custom homograft was created at that point, and a flat silicone sheet was used for the repair instead (Fig. 87). Another round of simulation used the first version of the custom 3D printed homograft patch to repair the pre-op HLHS model (Fig. 88). Feedback from the surgeon from the first homograft patch was used to create an improved second version of the patch, which was designed to better repair the aortic arch (Fig. 89).

Fig. 87: Result of preliminary surgical simulation using aortic arch models (0.8 mm wall thickness) and a flat 1 mm thick silicone patch (in pink). A: pre-op HLHS aorta anatomy. B: first attempt using silicone patch for repair of pre-op anatomy. C: second attempt using silicone patch. D: post-op HLHS aorta anatomy.
Fig. 88: Result of surgical simulation using version 1 of the homograft patch. 7-0 Prolene monofilament sutures were used for the repair. Left: view of model from left. Middle: anterior view. Right: view of model from right.

Fig. 89: Result of surgical simulation using version 2 of the homograft patch. 7-0 Prolene monofilament sutures were used for the repair. Left: view of model from left. Middle: anterior view. Right: view of model from right.
Some of the 3D printed models from this thesis project can be viewed at the Department of Art as Applied to Medicine or the Carnegie Center of Surgical Innovation at the Johns Hopkins University School of Medicine in Baltimore, Maryland. For access requests for the STL files of the 3D models, the author can be reached via email at sarahalicichen@gmail.com or through the author's website at www.sarahachen.com. The author can be reached through the Department of Art as Applied to Medicine website at www.medicalart.johnshopkins.edu as well.
DISCUSSION

Overall, this research project yielded successful and promising results, and a novel, reproducible workflow was documented for designing customized 3D printed cardiac models for use in surgical planning/simulation of the stage I Norwood operation. While conducting research into this process, several concepts and sources of information were investigated that bear further discussion.

WORKFLOW

The proposed workflow details each of the major steps in creating 3D printed models for surgical planning, from imaging data acquisition and segmentation to model design and physical 3D printing. Although the focus of this particular workflow was aimed at creating models of aortic arch abnormalities seen specifically in HLHS patients, the same concepts can be applied to other congenital variants and anomalies of the aortic arch, which account for 0.5–3% of the population (Hanneman et al., 2017 and Raimondi & Warin-Fresse, 2016). Models of other CHDs can also be created by using the basic concepts presented in the workflow.

The workflow presented several options for imaging data acquisition, segmentation software, and post-processing methods. The workflow accommodates the use of data from 3D ultrasound scans as well as CT or MRI scans. The creation of ultrasound derived models in particular provides an option for creating models through a safe and cost effective imaging modality, as ultrasound requires no radiation, contrast, or sedation, is relatively more accessible, and less costly than CT or MRI.

In addition, the workflow presents several segmentation software options. Although the list included is not comprehensive (as there are more software options), it includes a range of software that can accommodate different platforms (PC vs. Mac) and price ranges, as well as FDA cleared vs. open source software. The workflow also offers two ways for optimizing the 3D models derived from segmentation software; one is FDA cleared CAD software (Materialise 3-matic), and the other is non-FDA cleared, but free, 3D design software (Autodesk Meshmixer).

Considerations and limitations regarding imaging data acquisition, the segmentation software used in this project, and the 3D model design process will be addressed in more detail as follows.
CARDOVASCULAR IMAGING DATA ACQUISITION

The first step in the 3D printing workflow, imaging data acquisition, turned out to be the limiting factor for creating the 3D models, and was the most challenging hurdle to overcome during this research project. As previously mentioned, there is a discrepancy in that a majority of 3D printed models, especially cardiac models, are derived from CT and MRI; yet, most cardiac imaging is done through ultrasound. This is the case for pre-op HLHS imaging; the current standard calls for CT or MRI scans of HLHS patients only after stage I palliation, so no pre-operative HLHS CT/MRI data was available. However, as the value of 3D printed pre-operative CHD models come to light, improved practices for these CT/MRI imaging modalities may help facilitate safer ways to obtain high resolution data for 3D printing. For future applications, a comprehensive study assessing the effectiveness of creating models from such pre-op CT/MRI data could perhaps justify obtaining advanced scans of neonates before surgery to help plan the procedure, if the benefits of 3D printed models are proven to outweigh the risks of CT/MRI imaging.

CT/MRI

Although CT and MRI scans are often not the imaging modality of choice for diagnostic and routine follow-up imaging purposes when assessing CHDs, they still provide the highest resolution scans, which are ideal for creating medical 3D models. Factors that impede the use of CT in particular are radiation concerns. This is the first generation in which most HLHS patients survive into adulthood, and with increasing life spans, radiation exposure and its inherent longer-term risks will require more vigilant monitoring. High cumulative radiation exposure for patients undergoing surgical palliation for complex CHDs like HLHS makes it increasingly important to stress safer imaging techniques (Walsh et al. 2015).

In light of increasing usage of radiologic imaging, the Image Gently Alliance—backed by the Society for Pediatric Radiology and the American College of Radiology—was formed to raise awareness of opportunities to lower radiation dose in pediatric imaging (Image Gently, 2014). Image Gently calls for health care workers in radiology to carefully determine appropriate radiation techniques for
Discussion

pediatric imaging, due to children’s higher sensitivity to radiation (because higher rates of cell division in children make them more prone to genetic disruption) and potential lifelong effects (Walsh et al, 2015). This notion complements the “As Low as Reasonably Achievable” (ALARA) principle, which encourages choosing the best compromise between patient radiation dose and image quality.

Ongoing studies have investigated ways to improve the safety of CT scans. One study demonstrated a 30% iodine load reduction by using a lower concentration iodine contrast agent, while still maintaining accurate, diagnostic image quality (Hou et al., 2016). Newer generation scanners are also becoming more suited to respond to the challenges of pediatric and neonatal imaging, with advanced scan options and quicker scanning times (Booij et al., 2015). Other studies have shown that with proper technique, cardiac CT can be performed on free breathing neonates without sedation, without compromising image quality (Han et al., 2013). As for the anesthesia risks from MRI, more recent reports have documented that it is possible to avoid anesthesia when obtaining MRI scans of infants younger than 6 months of age (Jonas, 2014). With these improved practices, CT and MRI scans may become increasingly safer options to assess CHDs in pediatric patients.

3D ULTRASOUND

Of course, a way to circumvent use of CT or MRI scans for creating 3D printed models is to use 3D ultrasound data. Ultrasound is a safe bedside tool that is performed without radiation, contrast, sedation, or anesthesia, and can provide adequate image resolution. Methods for using 3D ultrasound data for creating models were investigated in this research project, and led to a couple of unique solutions. The clinical applications of 3D ultrasound have been demonstrated for cardiac models of valvular and septal CHDs; research from this project demonstrated that ultrasound-derived aortic arch models are feasible as well.

However, for this imaging modality to be more widely adopted for 3D printing, some of the limitations must be addressed. One issue noted from this research was the need for a more streamlined way of integrating ultrasound data into segmentation software. Native ultrasound imaging data are not represented using Cartesian voxels, making it incompatible with most segmentation software. In
addition, unlike CT and MRI data, 3D ultrasound data is not readily available through PACS servers, and as a result, accessing and importing ultrasound files was cumbersome. Finally, the model created for this project was heavily processed, since the initial imaging data retained some grainy qualities, and quite a bit of manual effort went into isolating and segmenting the arch. An algorithm-protocol for optimizing the image, by adjusting the resolution setting to better delineate anatomy of interest with less noise, would be helpful for creating better quality models.

Eventually, development of more powerful matrix probes in the near future may help mitigate some of these issues. With 3D ultrasound, the windows are also still limited and whole heart imaging is not yet plausible, but it is also important to note that the aortic arch model created in this project was derived from 3D ultrasound imaging of an adult. The same method used to scan a neonatal patient may actually be more effective, as infant anatomy is relatively much smaller than that of an adult, while the size of the window remains almost the same. This would result in showing quite a bit more arch anatomy in an infant using 3D ultrasound. **Fig. 90** shows an example of ultrasound done to assess arch anatomy in an infant with hypoplastic aortic arch anatomy, with much of the structures visible in the view.

![Suprasternal notch view of a neonate with a hypoplastic aortic arch and a large ductus arteriosus, using ultrasound. Most of the aortic arch anatomy of interest can be seen from this view.](image)

**Fig. 90:** Suprasternal notch view of a neonate with a hypoplastic aortic arch and a large ductus arteriosus, using ultrasound. Most of the aortic arch anatomy of interest can be seen from this view (image from Echocardiography in Pediatric and Congenital Heart Disease, 2e).
3D FETAL ULTRASOUND

Another potential solution lies in the use of 3D fetal ultrasound, from which a proof of concept model was successfully created for this project. With the advances in fetal ultrasonography, the resolution of fetal ultrasound data can be quite good, and certainly adequate for creating models. An academic literature search of other 3D printed fetal heart models yielded minimal results, so the fetal cardiac model created in this project may be one of the first of its kind.

Fetal ultrasound has potential for providing improved CHD visualization, but one of the major limitations is that much of the advanced functions like STIC, TUI, and B-flow imaging are still only available in newer, more sophisticated ultrasound devices, which prevents widespread use of this technology for routine CHD screening. However, many studies have already demonstrated that advanced 3D/4D ultrasound imaging favors and boosts detection of CHDs (Araujo Júnior et al., 2014 and Zhang et al., 2016). Timing (i.e. gestational age) is also a factor to consider when creating fetal heart models. According to one study’s measurements, the size of a fetal heart at the end of the second trimester (24–28 weeks) is 29 mm; at 28–32 weeks, the size reaches 34 mm, by 32–36 weeks, it averages 41 mm, and by end of term at 36–40 weeks, the heart is 44 mm (Kumari, et al., 2012). The model created for this project was from a fetus at 27 weeks, and so future applications for creating models in this way may attempt the creation of fetal heart models at later stages in gestation, closer to term.

As the interest in and applications of medical 3D printed models gain momentum, manufacturers of ultrasound machines are also incorporating more 3D printing applications with advances in ultrasound imaging. To illustrate this point, one of GE’s advanced 3D/4D ultrasound machines helped detect aortic stenosis in a 28-week old fetus at Phoenix Children’s Heart Center. Left untreated, there was a chance the defect could have developed into HLHS, but cardiologists were able to perform surgery in-utero through a needle to repair the defective aortic valve, by using ultrasound technology. Ultrasound was the primary source of imaging and information before and during the operation; after the surgery was completed, the data were used to create a 3D printed model of the heart before and after the repair (newsroom.gehealthcare.com, 2017).
Ultrasound derived 3D prints are already being explored as a method for potentially improving fetal surgery. In 2015, the Fetal Health Foundation awarded a grant to researchers at the Johns Hopkins Center for Fetal Therapy, to support a 3D printing project for creating ultrasound derived models of babies in utero with Spina Bifida. The project sought to create high fidelity 3D printed models of the fetus and the anomaly, to help surgeons plan for open fetal surgery, and thereby reduce risks and complications (Fetal Health Foundation, 2015). Overall, creating prints from fetal ultrasound data may provide unprecedented access to understanding complex CHD while the baby is still in utero. It is an appealing option to create late third trimester fetal heart models in particular, since stage I palliation for HLHS must be performed often just days after birth, and a model created while the baby is still unborn may potentially give surgeons more time to plan for life-saving surgeries.

**SEGMENTATION**

After image acquisition, the next challenge was segmentation of the data. In this research, six segmentation software options were explored. Many had similar workflows that included thresholding and editing masks in 3D; still, no one workflow was the same, and each software had unique strengths. Mimics continues to be the most widely used segmentation software for academic and clinical use (Byrne et al., 2016). Mimics offers robust tools for segmenting the DICOM data, as well as tools to help optimize the model after segmentation. Mimics is also the only FDA approved software available for segmenting non-Cartesian data, which is an important consideration for creating ultrasound derived models.

InPrint offers a very user friendly workflow, which was designed to create a 3D printable model straight from DICOM data in 5 designated, easy to follow steps. The author was fortunate enough to have access to the beta version of InPrint 2.0 for evaluation as well, which offers several improvements—such as the 3D “Interpolate” tool to create/edit a volume and the separate “Hollow” tool—over the previous version. For both Mimics and InPrint, Materialise representatives provided comprehensive support for this research project, and experts were quick to provide help with any technical issues. Materialise software is available only for Windows.
OsiriX MD remains the only FDA cleared segmentation software for Mac operating systems. Accurate models were able to be created from OsiriX MD; the steps involved were not immediately obvious, but with the help of some instructional videos, models were generated fairly quickly.

Vitrea includes a number of robust protocols for isolating very specific anatomical regions (for example, the aortic valve or the carotid artery vasculature), which are especially helpful for visualization and diagnostic imaging. The complexity and number of tools available makes this software appealing for a dedicated radiologist, but for purposes of this project, many of these diagnostic tools that were designed to be clinically useful were not applicable to 3D printing. 3D print options are certainly supported, but the user interface suggested that 3D printing options were designed as an ancillary feature. Vitrea is only available for Windows.

D2P is not yet available for commercial use, but it offers a user friendly workflow with novel virtual reality applications embedded in the program. D2P stands for “DICOM-to-Print,” and the name is appropriate, given the streamlined workflow that took the user from the DICOM images to the 3D mesh model in a few steps. D2P is only available for Windows.

3D Slicer, one of the open source, free software options that are available, offers one of the most versatile segmentation options in terms of platform availability, since it is available on Windows, Mac OS X, and Linux. However, it is not FDA cleared and intended for research purposes only. The segmentation process used in this project involved thresholding and editing the mask in 3D, but the tools were not readily identified on the interface and required some time to figure out the workflow.

Each of the models generated from the above mentioned segmentation software was analyzed through the Meshmixin “Inspector” tool. The most common problems were small manifold areas, followed by non-manifold edges. The model generated from inPrint required the least amount of repair, while the model from 3D slicer required the most. It should be noted that only one CT data set was used to evaluate each software, so these results do not necessarily reflect the true efficacy of the segmentation software. Moreover, for each of the six segmentation results, the “Repair” function in Meshmixer easily fixed any geometry problems of all of the models with a single click.
One issue that came up in using these segmentation software options was the lack of standardized terminology when using the different segmentation tools. For example, what is considered a “Region of Interest” (ROI) in one software is called a “mask” in another, and the term “mesh” in one software is identical to “3D Object” in another. Another observation made during the segmentation process was the usefulness of having a tablet and stylus available. This was especially helpful when editing 3D volumes, when refined regions for cropping had to be drawn out.

Overall, the cost of the software was associated with the clarity and user-friendliness of the interface for creating 3D models, as well as the availability of any dedicated semi-auto segmentation protocols and FDA certification. An ideal segmentation workflow would be one that is easy to navigate, accurate, time efficient, and FDA cleared. For most medical 3D print projects, segmentation remains a crucial step to the process. Many imaging providers, such as Carestream, are incorporating protocols into their software to output STL files without the need for third part segmentation software. Another one of the leaders in advanced visualization, TeraRecon, has teamed up with WhiteClouds, a full-color 3D printing cloud provider, to establish a 3D printing process with “no need” for “third-party software” or the “use of large STL files.” Their workflow, marketed as “the first enterprise 3D printing solution for hospitals,” uses an application called the 3D Print Pack, embedded in the TeraRecon software, to enable online, cloud-based 3D reconstruction that can be directly 3D printed (Imaging Technology News, 2017). This differs dramatically from the current prevailing workflows in which the segmentation process inevitably includes producing an STL file, and only time will tell if TeraRecon’s new service will gain popularity.

**DIGITAL MODELING PROCESS**

After the segmentation process, the 3D models were brought into Meshmixer for further optimization and modifications (such as cropping, hollowing, and creating supports). Although many 3D software options were available, Meshmixer was chosen for purposes of this research project because of its accessibility (Meshmixer is available for Windows, Mac OS X, and Linux) and cost-effectiveness (Meshmixer is free). It is also fairly user friendly with an intuitive and easy to learn interface, and offers
Discussion

Meshmixer is also designed for creating 3D print-ready models and provides functions that can easily repair common mesh problems. However, Meshmixer is not FDA cleared software. For repairing and optimizing the segmented models through an FDA validated pathway, 3-matic is certified for use with clinical purposes to ensure patient safety. While Meshmixer is 3D design software with emphasis on digital sculpting tools, the 3-matic interface is more in line with CAD modeling software that allows for device design as well as mesh optimization.

When discussing the validity of creating medical 3D printed models for clinical purposes, it is also crucial to address FDA medical device classifications and intended applications for 3D printed models. The FDA classifies medical devices into three categories, based on the risk profile of the device. Class I devices are low risk and therefore subject to the least regulatory controls (e.g. dental floss), Class II devices are higher risk (e.g. condoms), and Class III devices are highest risk and require the highest levels of regulatory control (e.g. heart valve replacements) (U.S. FDA, 2015). Generally speaking, there are three common intended purposes for 3D printed medical models, which roughly correlate with the FDA class designations. Christensen & Rybicki have summarized the three applications as follows: (1) Group I: Anatomical Models, which represent anatomy as-scanned, and are intended for visualization and surgical reference and planning; (2) Group II: Modified Anatomical Models, which are anatomical models that have been modified or enhanced, and may have been manipulated digitally for simple surgical planning; and (3) Group III: Virtual Surgical Planning with Templates, which involve the creation of 3D printed templates, models, and/or guides produced from complex surgical planning done digitally, intended to augment surgical procedures with specific pre-planned steps which are carried out in surgery using 3D printed guides or templates.

The HLHS models in this project that were digitally manipulated to create the approximated post-op anatomy and homograft shape fall into the Group III category, and it is important to note that these models that were created by applying “Major” changes. “Major” changes include digitally resecting or reconstructing structures, mirroring anatomy to “perfect” a unilateral defect, providing graft/implant templates, and simulating intervention using another medical device that results in the alteration of
the model. “Minor” changes, on the other hand, are applicable to Group I and Group II models (such as the ultrasound derived prints in this project), and include simple alterations to make the model more “printable” or to enhance it in a way that does not alter the anatomy, such as repairing holes in anatomy from imaging artifacts, smoothing, adding supports, adding a wall around contrast-enhanced anatomy like vessel lumens, labeling, cropping, and adding color to highlight structures. If these “Minor” changes are made to models using software that is appropriately FDA cleared (like the Materialise software, for example), the resulting models are generally approved for clinical use (Christensen & Rybicki, 2017).

From the FDA’s perspective, 3D prints of patient anatomy models should be unaltered if intended for diagnostic or clinical purposes; if the anatomy is altered through the use of software in anyway and indicated for diagnostic use, consultation with the FDA is recommended (Di Prima et al., 2016). This would certainly be the case for the post-op HLHS model and homograft models from this project, which were created by significantly altering the anatomy with "Major" changes and using Meshmixer, a non-FDA cleared software. As such, future endeavors for creating surgical simulation models must be carefully created using FDA cleared software for best clinical safety practices. To help facilitate the standardization of 3D printed models, America Makes, the National Additive Manufacturing Innovation Institute, and the American National Standards Institute (ANSI) announced in February of 2017 the publication of a Standardization Roadmap for Additive Manufacturing, specifically established to accelerate the development of industry-wide additive manufacturing standards and specifications (ANSI, 2017). Through the efforts of ANSI and similar organizations, 3D printing technology can play a more standardized role in the medical sphere.

### 3D PRINTED MODELS

With regard to the actual physical prints, some of the limits of the Stratasys printer used in this exploration were assessed. Although thicknesses of less than 1.5 mm are generally not recommended for the Stratasys Tango Plus clear flexible material, a series of test prints showed that models as thin as 0.7 mm could be reliably printed. At 0.6 mm, the walls of the model were too fragile, and the model
Discussion

tore too easily despite attempting careful removal of the SUP706 support material.

In fact, the main issue encountered with printing hollow vessels with thin walls was not due to the resolution of the printer itself, but limited by how successfully the Stratasys SUP706 support material could be removed. It was determined that using the Stratasys WaterJet system for cleaning out support material was too powerful for cleaning small, delicate structures, and the innovative use of a more gentle WaterPik water flosser was key to successful removal of the support without tearing the thin 3D printed model walls. Some tearing did occur, however, even when cleaning the prints with care, and some residual SUP706 support material remained in hard-to-reach areas of the model lumen. Soaking the models in a tub filled with 2% NaOH solution for up to an hour was recommended by Stratasys, in lieu of using their dedicated CleanStation SRS-DT3 washing unit. This helped dissolve extra support material, but the caustic solution had to be used judiciously, to avoid dissolving the actual model as well.

Overall, the 3D printed models of the pre-op and post-op HLHS anatomy and homograft template were deemed a success by the pediatric cardiothoracic surgeon assessing the models. The original research question was to determine whether a homograft patch could be digitally designed and 3D printed. The first version of the homograft patch did not take into account repair of the coarctation, and was subsequently updated in the second version of the homograft patch. As hoped, this patch fit nicely to repair the pre-op HLHS model, with very positive feedback from the surgeon. The 3D ultrasound derived aortic arch model and 3D fetal ultrasound derived cardiac model were also met with approval, and were successful proof of concept prints that suggested that this type of imaging modality and technology can be used to, in fact, create CHD prints if applied appropriately. These models not only have the potential to be used for planning and simulation, but also can be used as teaching aids for residents and fellows learning the surgery.

Constructive feedback about the models mostly addressed the tackiness of the Tango Plus material, which hindered the suturing process. Stratasys did advise submerging the models in a 15% glycerol solution for 30 seconds to remove the sticky quality of the material, but due to time constraints,
this option was not explored and will be reserved for future iterations of the model. In addition, the models created for this project were printed in a single material in one color. The addition of color to the models may be helpful for future prints. However, even without color, the resulting prints were more than suitable for the intended purpose of surgical planning.

Although the combination of Stratasys PolyJet technology using Tango Plus material worked well for purposes of this project, it imposed a limit to the wall thickness, and the material did not quite have the same flexible qualities as real vascular tissue. For further exploration, new technology developed by Carbon, called Continuous Liquid Interface Production (CLIP), could be used to print these thin, fragile models. CLIP technology allows objects to grow from a pool of liquid resin instead of printing the shape layer-by-layer (which is the current method used by most 3D printers), and as a result the prints are highly resilient even when printing very thin models. Carbon’s Elastic Polyurethane (EPU) material in particular may be of interest for printing vascular models, due to its excellent elastomeric properties and high resolution. In addition, CLIP technology cuts print time drastically, because of its fast printing speed and minimized use of support material, which lessens the cumbersome support removal processes (Carbon, Inc., 2017).

Finally, it is worth noting that another future application of 3D printing for clinical use lies in 3D bio-printing. 3D models created from imaging modalities like CT, MRI, and ultrasound have the potential to be printed using custom biomaterials to create patient-specific, tissue engineered grafts for reconstructive cardiovascular procedures (Hibino Lab website, 2017). 3D models of the homograft model created from the same workflow identified in this project, for instance, could someday be printed using synthetic or patient-derived biomaterials that can be implanted directly into the patient for superbly personalized surgeries.

OVERCOMING OBSTACLES AND FUTURE OBJECTIVES

Despite the promises that medical 3D printed models hold, widespread use of 3D printing in the clinical setting is still limited by lack of robust and quantitative evidence demonstrating its effectiveness, along with workflow complexity and high costs of printing (including segmentation software as well as the
Discussion

printer itself, and associated upkeep and material costs). The accuracy and reproducibility of medical 3D printed models still need to be defined and tested, starting with standardization of source image data acquisition and post-processing techniques. Several factors can influence the model accuracy; image segmentation is still intra- and interoperator dependent and the variability must be assessed.

However, these issues are beginning to be addressed more seriously and systematically. An organization called OpHeart is working with clinicians, health care providers, 3D printer manufacturers, software developers, medical device companies, third-party payers, and families of CHD patients to “get doctors access to 3D printed models of patients’ heart for the benefit of as many children as possible.” OpHeart is helping fund a 3D print study proposed by pediatric cardiologists at the Children’s Hospital of Philadelphia and Children’s National Medical Center, to evaluate the effects of patient-specific 3D printed cardiac models for pre-operative planning. The drive behind this study is affirm that 3D printing is an “indispensable” tool in the treatment of CHDs, and to empirically prove the financial efficacy of 3D printing to insurers (OpHeart, 2017).

Cost, of course, remains one of the biggest obstacles preventing a more pervasive use of 3D prints in hospitals. To incentivize 3D printing and ensure that insurance companies will be on board to fund the models, Current Procedural Terminology (CPT) codes for 3D printing services would need to be established. CPT codes are published by the American Medical Association (AMA), and provide a uniform standard for describing medical, surgical, and diagnostic services. Assigning a CPT code to medical 3D printing services would make it possible for insurance companies to allocate payment for software and hardware involved in creating 3D prints, and would also ensure that healthcare providers would be appropriately paid for their time and services, especially since the segmentation process involved in the 3D printing workflow can demand quite a bit of time and expertise from radiologists, cardiologists, sonographers, and other technicians.

These steps are not inconceivable, and Japan has already paved the way for legitimizing medical 3D printing. In 2016, Japan’s Central Social Insurance Medical Council announced that the cost of medical 3D printed models used to augment clinical and surgical treatments would be covered under
Discussion

the standard medical insurance payment range (3ders.org, 2016). The U.S. is primed to follow suit and embrace the advantages of medical 3D printing in a more clinical setting. Current funding sources for medical 3D printing in the U.S. is largely from research grants and private payers, but shifting the cost to insurers would allow for more extensive use and advancement of medical 3D printing technology.

Still, despite current barriers to defining and implementing a more widespread, standardized protocol for seamlessly integrating medical 3D printing into the standard of care, measures are slowly but surely being taken to facilitate the official adoption of this life-changing technology in a clinical setting. Cardiovascular 3D printing has revolutionized personalized medicine, and has the potential to further improve patient-specific management, research, surgical education, and development of clinical tools. 3D printing can play a critical part in the multidisciplinary and collaborative efforts involved in cardiovascular diagnoses and treatment strategies.
CONCLUSION

The applications of 3D printing technology for surgical planning and simulation were explored in this research project, and yielded promising results for future investigations. Medical 3D printing is a fast evolving field, and combined with new advances in medical imaging techniques, has the potential to provide an unprecedented tool set for surgeons to help visualize complex anatomy and simulate specialized procedures.

3D printed models were created from CT, as well as ultrasound, data. These included life-sized 3D printed models of pre-operative aortic arch anatomy of HLHS, derived from creative digital manipulation of CT data, as well as an approximation of the desired post-operative anatomy and the homograft shape used in the aortic arch reconstruction of HLHS patients. The models were printed in a clear, flexible Tango Plus material on the Stratasys Connex3 Object260 printer. Innovative solutions for post-print processing resulted in 3D printed vascular structures with very thin walls, enabling the surgeon to suture through the walls of the print, thus simulating the surgical repair.

In order to assess the possibility of printing from ultrasound, proof of concept models were also successfully created from 3D ultrasound and 3D fetal cardiac ultrasound data. Subsequent research should heavily stress ways to improve ultrasound derived prints, since ultrasound is commonly used during the diagnostic phase and offers a safer, less costly, and more available imaging modality than CT or MRI. In addition, a reproducible workflow was documented for creating customized medical 3D printed models. The research addressed multiple options for each of the steps in the 3D printing process, and presented a workflow using FDA cleared options for ensuring best clinical safety practices.

Finally, the collaborative nature of medical 3D printing was also stressed throughout this research process. Without the efforts of experts in a multitude of medical disciplines, the successes of this project would not have been possible. The real heart of 3D printing lies in the ongoing endeavors of the clinicians, surgeons, technicians, health care providers, and medical artists who are steadfastly working to apply this technology into an ultimate medical goal—longer, healthier lives for patients.


Works Cited


---

91
Works Cited


Sarah Chen was born in Tokyo, Japan, and grew up in Santa Cruz, California. She received her BS in Health Sciences at the University of California, Santa Cruz, graduating *magna cum laude*, in 2010. In 2011, she completed a graduate certificate in Science Illustration at California State University, Monterey Bay. In 2013, Sarah entered the MD program at the University of California, Davis School of Medicine. Soon after starting her third year of medical school, she decided to take a two-year hiatus to pursue her masters in Medical and Biological Illustration at the Johns Hopkins University School of Medicine. She will be returning to UC Davis in the summer after finishing her illustration degree in May of 2017, and will graduate in 2019 with an MD degree.

Sarah finds the immediate usefulness, accessibility, and didactic value of medical illustration superbly gratifying, and entered the field of medical illustration to broaden the applications of this incredibly powerful—but still underutilized—discipline in health care. She recognizes that medicine is rapidly becoming more visual; advances in imaging offer incredible views of the body, and matched with improvements in digital software and 3D printing technologies, there is an unprecedented need for medical specialists and visual storytellers to utilize this body of knowledge to enhance patient care. With this in mind, Sarah intends to pursue a hybrid career in medicine and illustration, with hopes to strengthen the collaboration between medical illustration and clinical medicine. She will continue to pursue 3D printing projects for surgical planning purposes upon her return to medical school.

In her spare time, Sarah enjoys traveling abroad, painting her nails, kickboxing, and martial arts. She is enamored with the color red, and can be seen in the clinic sporting her bright red stethoscope. More of her work can be viewed at sarahachen.com.